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AABBOOUUTT  TT HHIISS  MMAA NNUUAALL   
 

Purpose of this manual 
 

This manual guides a system administrator in setting up and 
maintaining an Atlas WAV system after installation by a certified 
professional.  This manual provides a valuable reference guide for 
making changes to the system. 

 

Information contained in this manual 
 

The chapters of this Atlas WAV contains the following 
information: 

 
Chapter 1 explains how to maneuver through Atlas WAV. 
 
Chapter 2 is quick guide to system administrating. 
 
Chapter 3 explains what the Auto Attendant is and how to program the Atlas 
WAV as an Auto Attendant.   
 
Chapter 4 explains how to set up a basic Atlas WAV system. 
 
Chapter 5 describes some of the more advanced features. 
 
Chapter 6 describes the Atlas WAV Main Screen, Port Status Screens and 
Scheduler screen. 
 
Chapter 7 describes all forms, menus and lists found under the subscriber field. 
 
Chapter 8 describes additional edit menus found in the main dialog. 
 
Chapter 9 describes additional edit menus found in the file area of the main dialog 
and also explains all signaling definitions. 
 
Chapter 10 contains troubleshooting information. 
 
Chapter 11 contains technical tips about the Atlas WAV. 
 
Chapter 12 contains useful forms for planning your Atlas WAV system. 
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Conventions 
 
 

Convention Key Information 
Lowercase x indicates a variable in a file, version, etc. 
ALL CAPS indicates a file or directory 
< italics > indicates a variable or place holder 

: example of a “path” that a user can follow to get 
to a particular screen or field. 

< > indicates a keyboard command such as < Enter > 
Lowercase bold used for commands or data to be typed at the 

keyboard 

¤Note: 
information that is vital to the success of a 
process 

æTip: 
a shortcut or helpful hint 

I Caution: 
possible damage to equipment 

 
 

UUSSIINN GG  AATTLLAA SS  WWAAVV  
 

The Atlas WAV is a computer telephony solution that integrates 
with Microsoft’s Windows operating systems.  The Atlas WAV 
uses standard computer hardware to integrate electronic data and 
voice messages in an accessible format.  In addition, The Visual 
CTI interface, a Windows based “visual voicemail” application, 
allows end users to initiate voicemail commands from the desktop.   

 

Starting the Atlas WAV 
 

To start the Atlas WAV click on the Start button on the Windows 
toolbar, select Programs, select Key System US and then select 
AVM.   
 
The second way you may start the program by clicking on Start, 
selecting Run and then typing in “C:\Program Files\Key System 
US\WAV”. 

 
 

Exiting the Atlas WAV 
 

To exit the system, select File from the main toolbar and then 
select Exit.  The system will ask you if you are sure you want to 
shut down the system, select Yes. 
 
 
 
 
 
 

¤Note: 
You must be 
logged into the 
system before 
exiting. 
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Figure 1-1: The System Exit Window 

 

Types of Screens in the Atlas WAV 
 

There are five type of graphical boxes, or screens, used in the 
Atlas WAV.  These are menus, lists, forms, confirmation boxes 
and information boxes.  These Windows type screens provide 
information about the system and contain fields where the installer 
or administrator may modify system parameters. 

 
Menu 

 
• Offers choice among dissimilar items. 
• Can be navigated by using cursor movement keys or a      
       mouse. 
• You can jump to a line by typing the first letter of that  
       line. 
• Any item that is enabled will have a check mark next to it. 

 

 
 

Figure 1-2: Example of Menu 

 
List 

• Offers a choice among like items. 
• Can be navigated by using cursor movement keys or a  

mouse. 
• You can jump to a line by typing the first letter of that  

line. 
 
• May have up or down arrows if lists extend beyond  

¤Note: 
When you shut 
down the system 
it will end all 
calls currently in 
progress. 
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screen. 
 

                        Figure 1-3: Example of a List 

 
 

Form 
• Has Fields where you can enter or change information. 
• Fields can contain sub-menus. 
• Can be navigated using the TAB key or a mouse. 
• Has both read only information and variables. 
 

Figure 1-4: Example of a Form 

 
Confirmation Box 

• Appears when the system requests an input from the  
administrator. 

• Offers a choice of Yes or No only. 
• Although confirmation boxes are referred to as needed, 

they are not generally shown in this document. 
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Figure 1-5: Example of a Confirmation Box 

 
Information Boxes 

• Displays read-only information. 
• Has multiple levels.  (Indicated by a “+” sign next to a  

particular option.) 
 

 

Figure 1-6: Example of an Information Box 

 
 

Atlas WAV Runtime Help 
 

The Atlas WAV was designed with a built in online help option.  
If you require information on any particular item of field simply 
select, or go to, that field and press the F1 key.  This will bring up 
a help box on that particular item.  You may also refer to the 
online manual for a more detailed explanation of that particular 
field/option. 
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Saving Your Changes 
 

After you have finished editing parameters in a form or making 
changes on a menu, you must save your changes for them to take 
effect.  To save your changes click on File, or press the <ALT> 
key followed by the <F> key, and then select Save, or press the 
<S> key.  If you close the current screen before saving changes the 
changes will not be made to the system. 

 
 
 
 
 
 
 
 

¤Note:  
If you make a 
mistake in a form 
you can simply 
close that form 
and the changes 
will be discarded 
if you have not 
saved them. 
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 Quick Guide to System 

  Administration 
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This chapter is an overview of what you, as a system 
administrator, need to do to implement and maintain your Atlas 
WAV.  If your system is new, you will be helping to lay out the 
basic system design and to plan how to route incoming calls.  
After the system is in place you will be responsible for making 
modifications and additions as you administer the system. 
 
Before beginning, you need to understand a few basic terms used 
in the Atlas WAV. 

 

BBAASSIICC  AATTLL AASS  WWAAVV   TTEERRMMSS   
 

Group Box  A type of mailbox that takes messages and 
uniformly distributes them to other boxes.  

Subscriber A type of mailbox that is used for a individual. 
Department A type of mailbox used for a group of phones. 
Information A type of box that is used to provide pre-recorded 

information to an outside caller. 
ACD A type of mailbox used to evenly distribute the 

call volume between several subscribers. 
Visual Tree A type of box used to create a “Tree” for callers to 

get to a more specific option.  (i.e. Press 1 for 
Technical Support… Press 1 for telephone 
technical support or 2 for voicemail technical 
support.) 

Auto Attendant A set of prompts that are recorded to be 
played back to the outside callers when the 
voicemail answers an incoming call. 

Greeting A message recorded by a box owner to be played 
when a caller reaches their mailbox. 

PIN Number Allows box owners private access to their boxes 
and provides security for box owners’ messages. 

Log On/Off Allows private access to the system administration 
and the installation and integration portions of the 
Atlas WAV.  Only authorized personnel should have 
access to these passwords. 

Prompt A pre-recorded instruction played by the system 
over a telephone to a box owner or caller. 

 

Acronyms 
 

CO Central Office 

CPE Customer Premise Equipment 

CTI Computer Telephone Integration 

DID Direct Inward Dial 

DTMF Dual Tone Multi Frequency 

PBX Private Branch Exchange 
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POTS Plain Old Telephone System 

PSTN Public Switched Telephone Network 

SMDI Simplified Message Desk Interface 

SMDR Station Message Detailing Report 
 

SSYYSSTTEE MM  AADDMMII NNIISS TTRRAATT OORR  RREE SSPP OONNSSIIBB IILLIITT IIEESS   
 

As a system administrator, you are responsible for the setup and 
continuing management of your Atlas WAV.  Your duties include: 

 
• Helping the installer design your system. 
• Planning and implementing the Auto Attendant. 
• Planning and setting up Visual Trees. 
• Planning and setting up Subscribers and other type of boxes. 
• Recording greeting for the Auto Attendant as well as any other 

Visual Trees and Information Boxes. 
• Maintaining and modifying the Atlas WAV. 

 

AAUUTTOO  AATT TTEENN DDAANNTT  GGRR EEEETT IINN GGSS   
 

You can configure the Atlas WAV to work as an auto attendant to 
handle all of your incoming calls.  When you set up the auto 
attendant, callers have the flexibility to choose where their calls 
will be directed.  Callers may listen to pre-recorded Greetings, 
Information Boxes or Visual Tree Boxes.  The auto attendant can 
be configured to allow for single digit dialing options if required 
and also allows the caller the opportunity to transfer to an 
operator.  With the Voice Recognition option installed callers may 
simply ask for the person they wish to speak with. 

 
To set up auto attendant greetings, you must first decide what 
prompts need to be recorded and select a name for each prompt.  
You can string together several prompts to form a greeting.  For 
example you may want to have Good_Morning, 
Main_Day_Greeting for the morning greeting and 
Good_Afternoon, Main_Day_Greeting for the afternoon greeting.  
In this example the same main prompt is used just the first prompt 
is changed to indicate the time of day.  There are six different 
levels of greetings per day, so you may have up to six different 
greetings on any given day of the week.  For detailed information 
on setting up greetings, see “Setting Up the Auto Attendant” on 
page 3-3. 

 
After you have programmed the greeting parameters, you also 
need to record the audio portion of your greetings. 

 

:Screen Path: 
Select: 
• Editè 
• Hours of 

Operation 
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SSEETTTTII NN GG  UUPP  AATT LLAASS  WWAAVV   BBOOXX EE SS   
 

There are eight type of active boxes in the Atlas WAV.  They are 
Subscriber, Client, Department, Information, Group Box, 
Automatic Call Distribution, Visual Tree and Extension Only. 

 

Subscriber and Department Boxes 
 

Subscriber and Department boxes can be used for the following: 

• Record and store messages from both inside and outside 
callers. 

• Make and send messages to other box owners. 

• Give a copy of a message to another box owner. 

• Notify a box owner of newly received messages 

• Transfer a call to an extension. 

• Provide alternate call handling if an extension is busy or 
doesn’t answer. 

• Forward callers to other subscribers automatically. 
 

Programming a Subscriber or Department Box 
 

You may either program an existing box or create a new box.  
When you select Edit – Subscriber a list of all boxes currently in 
the system is displayed on the screen.  At this point you should 
either select one of the subscribers listed or select the close button 
on the top right corner of the list to create a new subscriber.  To set 
up and customize a subscriber box, use the following forms and 
menus.  The only difference between Subscriber and Department 
Boxes is that Department Boxes only allow for First name while 
Subscriber boxes allow for First and Last name. 

 
• Subscriber Setup Form 
• Activate Menu 
• ActivateèMessage Center Menu 
• Type Menu 
• Call Control Form 
• Device Setup Form 

 
Subscriber Setup Form 

 
The Subscriber Setup Form contains general information about the 
box. 
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Figure 2-1: The Subscriber Setup Form 

 
Activate Menu 

 
The Activate Menu allows you to enable or disable user features 
for the current subscriber box. 

 

 

Figure 2-2: The Activate Window 

: 
Screen Path: 
Select: 
• Edit à 
• Subscriber à 
• Choose Subscriber à 
• Or Close Choose 

Subscriber Window 
For New Subscriber 

 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Activate From 
Toolbar 
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ActivateèèMessage Center Menu 

 
The Activateà Message Center Menu allows you to enable or 
disable options the user will have while inside their mailbox. 

 

 

Figure 2-3: The Activate Message Center Menu 

 
 
Type Menu 

 
The Type Menu allows you to select the type of box the current 
subscriber is.  (Set this for either Subscriber or Department.) 

 

 

Figure 2-4: The Type Menu 

 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Activate From 
Toolbarà 

• Select Message Center 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Type From 
Toolbar 
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Message Call Control Form 

 
The Message Call Control Form allows you to change message 
and call delivery for the current subscriber. 

 

      
 Figure 2-5: The Message Call Control Form 

 
Device Setup Form 

 
The Communications Link Form allows you to change advanced 
options of the call transfer features for the current subscriber.  You 
may also create new devices for transfer purposes. 

 

  

Figure 2-6: The Device Setup Form 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Edità 
• Select Message Call 

Control 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Edit From 
Toolbarà 

• Select Communications 
Link 
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Client Boxes 
 

Client boxes are currently not used for anything.  They will 
eventually be used for speed dial type purposes through voicemail. 

 

Information Boxes 
 

Information boxes are used to provide information to a caller.  
This is in the form of a pre-recorded message.  The information 
box can then transfer a caller to an extension after the message is 
played and/or take a message from the caller. 

 
Programming an Information Box 

 
You may either program an existing box or create a new box.  
When you select Edit - Subscriber a list of all boxes currently in 
the system is displayed on the screen.  At this point you should 
either select one of the subscribers listed or select the close button 
on the top right corner of the list to create a new information box.  
To set up and customize an Information box, use the following 
forms and menus. 

 
• Subscriber Setup Form 
• Activate Menu 
• ActivateèMessage Center Menu 
• Type Menu 
• Device Setup Form 

 
Subscriber Setup Form 

 
The Voice Link Form contains general information about the box. 

 

 

Figure 2-7: The Subscriber Setup Form 

 
Activate Menu 

 
The Activate Menu allows you to enable or disable user features 
for the current subscriber box. 

: 
Screen Path: 
Select: 
• Edit à 
• Subscriber à 
• Choose Subscriber à 
• Or Close Choose 

Subscriber Window 
For New Subscriber 
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Figure 2-8: The Activate Menu 

 
 
ActivateèèMessage Center Menu 

 
The Activateà Message Center Menu allows you to enable or 
disable options the user will have while inside their mailbox. 

 

Figure 2-9: The Activate Message Center Menu 
 
 

Type Menu 
 

The Type Menu allows you to select the type of box the current 
subscriber is.  (Set this for Information.) 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Activate From 
Toolbar 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Activate From 
Toolbarà 

• Select Message Center 
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Figure 2-10: The Type Menu 

Device Setup Form 
 

The Device Setup Form allows you to change advanced options of 
the call transfer features for the current subscriber.  You may also 
create new devices for transfer purposes. 

 

  

Figure 2-11: The Device Setup Form 

 

Group Boxes 
 

Group Boxes are used to distribute messages among a group of 
two or more boxes.  The group box may contain all active 
subscribers and/or departments in the system.  These type of boxes 
are popular in Customer Support departments to distribute 
messages to the technicians. 
 

 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Type From 
Toolbar 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Edit From 
Toolbarà 

• Select Device Setup 
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Programming a Group Box 
 
 

You may either program an existing box or create a new box.  
When you select Edit - Subscriber a list of all boxes currently in 
the system is displayed on the screen.  At this point you should 
either select one of the subscribers listed or select the close button 
on the top right corner of the list to create a new Information box.  
To set up and customize an Information box, use the following 
forms and menus. 

 
• Subscriber Setup Form 
• ActivateèMessage Center Menu 
• Type Menu 
• Subscriber Group Selection List 

 
Subscriber Setup Form 

 
The Subscriber Setup Form contains general information about the 
box. 

 

 

Figure 2-12: The Subscriber Setup Form  

 
 
ActivateèèMessage Center Menu 

 
The Activateà Message Center Menu allows you to enable or 
disable options the user will have while inside their mailbox. 

 

: 
Screen Path: 
Select: 
• Edit à 
• Subscriber à 
• Choose Subscriber à 
• Or Close Choose 

Subscriber Window 
For New Subscriber 

 



Atlas WAV Chapter 2                                                                                                Page 11 

 

Figure 2-13: The Activate Message Center Menu 

 
Type Menu 

 
The Type Menu allows you to select the type of box the current 
subscriber is.  (Set this for Group Box.) 

 

 

Figure 2-14: The Type Menu 

 
Subscriber Group Selection List 

 
The Subscriber Group Selection List allows you to add or remove 
subscribers from the group box.  

 
 
 
 
 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Activate From 
Toolbarà 

• Select Message Center 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Type From 
Toolbar 
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Figure 2-15: The Subscriber Group Selection List 

 

Uniform Call Distribution Boxes 
 

Uniform Call Distribution Boxes are used to send callers to a 
group of two or more subscribers using a circular hunt method.   
This type of box is useful if you have a department(s) and you 
wish to evenly distribute calls among the personnel in that 
department. 

 
Programming a Uniform Call Distribution Box 

 
You may either program an existing box or create a new box.  
When you select Edit - Subscriber a list of all boxes currently in 
the system is displayed on the screen.  At this point you should 
either select one of the subscribers listed or select the close button 
on the top right corner of the list to create a new Uniform Call 
Distribution box.  To set up and customize an Uniform Call 
Distribution box, use the following forms and menus. 

 
• Subscriber Setup Form 
• Activate Menu 
• Type Menu 
• Uniform Call Distribution Selection List 

 
Subscriber Setup Form 

 
The Subscriber Setup Form contains general information about the 
box. 



Atlas WAV Chapter 2                                                                                                Page 13 

 
 

 

Figure 2-16: The Voice Link Form  

 
 
Activate Menu 

 
The Activate Menu allows you to enable or disable user features 
for the current subscriber box. 

 
 

 

Figure 2-17: The Activate Menu 

 
 

Type Menu 
 

The Type Menu allows you to select the type of box the current 
subscriber is.  (Set this for Uniform Call Dist.) 

 

 

: 
Screen Path: 
Select: 
• Edit à 
• Subscriber à 
• Choose Subscriber à 
• Or Close Choose 

Subscriber Window 
For New Subscriber 

 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Activate From 
Toolbar 
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  Figure 2-18: The Type Menu 

 
 

UniformCall Distribution Selection List 
 

The Uniform Call Distribution Selection List allows you to add or 
remove subscribers in the Uniform Call Distribution group. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 2-19: The Uniform Call Distribution List 

 

Visual Tree Boxes 
 

Visual Tree Boxes allow you to set up a multiple level system.  
The system will play a pre-recorded audio menu offering callers 
options on how their call will be directed.  The Visual Tree box 
allows you to have dial options for several different types system 
functions. 

 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Type From 
Toolbar 



Atlas WAV Chapter 2                                                                                                Page 15 

 
 
Programming a Visual Tree Box 
 
You may either program an existing box or create a new box.  
When you select Edit - Subscriber a list of all boxes currently in 
the system is displayed on the screen.  At this point you should 
either select one of the subscribers listed or select the close button 
on the top right corner of the list to create a new Visual Tree box.  
To set up and customize a Visual Tree box, use the following 
forms and menus. 

 
• Subscriber Setup Form 
• Activate Menu 
• Type Menu 
• Visual Tree Interface Form 

 
 
 

 Subscriber Setup Form 
 

The Subscriber Setup Form contains general information about the 
box. 

 
 

 

Figure 2-20: The Subscriber Setup Form  

 
 
 

Activate Menu 
 

The Activate Menu allows you to enable or disable user features 
for the current subscriber box. 

 
 
 
 
 
 

: 
Screen Path: 
Select: 
• Edit à 
• Subscriber à 
• Choose Subscriber à 
• Or Close Choose 

Subscriber Window 
For New Subscriber 
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Figure 2-21: The Activate Menu 

 
Type Menu 

 
The Type Menu allows you to select the type of box the current 
subscriber is.  (Set this for Visual Tree.) 
 
 

 
 

        Figure 2-22: The Type Menu 

 
 
 
 
 
 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Activate From 
Toolbar 

:Screen Path: 
Select: 
• Edità 
• Subscriberà 
• Choose Subscriberà 
• Or Close Choose 

Subscriber Window 
For New Subscriberà 

• Select Type From 
Toolbar 
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Visual Tree Interface Form 
 

The Visual Tree Interface Form allows you to define where or 
how different caller dialed digit entries are routed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-23: The Visual Tree Interface Form 
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MMAAIINNTTAA IINNIINN GG  YYOOUU RR  AATTLLAA SS  WWAAVV  
 

Some of the tasks required in the maintenance of your Atlas 
WAV are listed below: 

 
• Modify boxes as needs change. 
• Create new boxes or delete ones no longer needed. 
• Record new greetings and Visual Trees or modify existing 

ones. 
• Set up or modify Communication Links for box owners. 
• Troubleshoot problems.  



 
 
 
 
 

3 
 The Automated Attendant 

C H A P T E R  
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WWHHAA TT  IISS  TTHHEE  AAUUTTOO MMAATTEE DD  AATTTT EENNDDAANN TT??  
  

The Automated Attendant is a prerecorded greeting that eliminates 
the need for an operator because it allows callers to direct their 
calls.  When calls come in, the Automated Attendant greets the 
callers and informs them of various ways the callers can direct 
their calls.  Callers then make their selections by pressing keys on 
their telephones. 

 
There are two ways to use an Automated Attendant: the first is as 
a primary Automated Attendant the other is as a secondary or 
backup Automated Attendant.  A primary Automated Attendant 
answers every call that comes into the company.  A secondary 
Automated Attendant answers overflow calls that can not be 
answered by the operator. 

 
When programmed correctly, the Automated Attendant can: 

 
• Receive incoming telephone calls 
• Greet callers 
• Offer callers an audio menu of forwarding 

destinations to select from 
• Play recorded information, based on caller responses 

to an audio menu 
• Direct calls to an operator 

 

HHOO WW  AAUUDDII OO  MMEENNUU SS  WWOO RRKK   
 

An audio menu is a recorded message that verbally gives a caller 
options associated with keypad numbers.  Pressing the key 
associated with the option performs the action described by the 
option. 
 
The following is an example of an audio menu. 

 
 
 
 
 
 
 

Figure 3-1: An Example of an Audio Menu 

  
 
 
 
 
 
 

“For Sales, Press 2” 
“For Shipping, Press 3” 

“For a Company Directory, Press 4” 
“For an Operator, Press 0” 
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SSEETTTTII NN GG  UUPP  TTHH EE  AAUUTT OOMMAATT EEDD  AATTTTEENNDD AANNTT   
 

In a new Atlas WAV system there is a default greeting 
prerecorded.  This means that any calls coming into the system 
will receive this greeting.  To set up the Automated Attendant, you 
must program the Hours of Operation form, record a greeting and 
program the main greeting visual tree. 

 

Programming The Hours of Operation 
 

The Hours of Operation form allows you to define different 
greetings for different days, different times of day and different 
companies. 

 
To open the Hours of Operation box from the main screen select 
Edit - Hours of Operation.  The following form should now be on 
the screen. 

 
 

Figure 3-2: Hours of Operation Form 

 
Defining Which Prompts to Play 

 
The Atlas WAV allows for extreme flexibility in setting up the 
Automated Attendant Greetings.  The Administrator is able to use 
several different prompts strung together to create a single 
message for the outside caller. 

 
A prompt is a file that is recorded into the system and played back 
to callers.  These prompts can be up to 74 minutes long. 

 
Selecting which prompts to play will depend greatly on the setup 
that your customer requires.  There may be some instances where 
you only need one prompt defined for everyday all day and other 
instances where you need to very your prompts for different times 
of the day and different days of the week.  So before proceeding it 
is a good idea to determine what type of application you will be 
attempting to install. 

 

:Screen Path: 
Select: 
• Edità 
• Hours of Operationà 

¤Note:  
If you have more then 
one company defined 
in the system you will 
have to select the 
company before the 
Hours of Operation 
form will appear. 
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              Naming the Prompt to Play 
 

The prompt(s) to be played must have a name.  It is recommended 
that you name the prompt something that will be easily associated 
with what it is used for.  For example, if you wanted to have a 
prompt that said “Good Morning” you might call it 
good_morning or goodmorning.  In a multiple company 
application you might refer to this prompt as good_morning_abc, 
where “abc” is the company name. 

 
In the screen sample on the previous page you will notice that 
there are a few different prompt names on the same line.  This 
allows you to just record one main greeting and also allow for a 
different opening for the caller during different time of the day.  
For example the “OPEN” prompt is used in a couple of different 
time slots but it is proceeded by either “good_morning”, 
“good_afternoon” or “good_evening”.  Programming the hours of 
operation this way gives the caller a little bit more personal feeling 
when interacting with the voicemail. 

 
Defining Times of Day to Play Prompts 

 
Each level has a “From” and “To” field.  These are used to define 
the time period that a prompt is played for.  The only one of these 
fields that is settable is the “To” field.  The  “From” field is 
controlled by the previous levels “To” field. 

 
The “To” field is the time that you wish the current prompt to stop 
playing and the next level to start.  This time can either be entered 
in a 24 hour format or in a 12 hour format using AM and PM.  
There must be a colon between the hour and minutes.  For 
example 2 o’clock PM can be entered as either 02:00 PM or 14:00. 

 
Enabling Levels 

 
The Atlas WAV allows for up to six different greetings per day 
per company.  The number of greetings that are enabled is 
controlled by the “Levels” buttons.  On the screen these are 
labeled Closed, Morning, Lunch, Afternoon, Evening and Closed.  
This labeling is for reference only.  The levels do not have to be 
used for what they are labeled.   

 
To enable or disable a specific level simply click on the button for 
that level. If the button is pushed in that level is enabled if the 
button is pushed out it is disabled. 

 
You may have as few as one level enabled or as many as six.  
When enabling or disabling levels keep in mind that the system 
always looks at level one first and the level two etc.. until it finds 
an enabled level.  If there are no levels enabled the system defaults 
back to the previous greeting that was being played. 

¤Note:  
When naming 
prompts they 
have to be one 
word (no spaces).  
To space out a 
prompt name use 
the “_” 
(underline) key 
for a space. 

¤Note:  
When using the 
12 hour format be 
sure to put a 
space between 
the time and AM 
or PM 
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Selecting Day of Week 
 

The current day of the week that you are programming is located 
at the left hand side of the form.  To select a different day click on 
Day of Week and then click on the day you wish to program or 
press the <ALT> key followed by the <D> then use the arrows to 
select the day you wish and press the <Enter> key. 

 
Copying Prompts to Different Days 

 
To copy the settings from one day to another select the day you 
wish to change (see the previous paragraph).  Then click on Copy 
From and then click on the day of week you wish to copy the 
settings from or press the <ALT> key followed by the <C> key. 
Then use the arrow keys to select the day of the week to copy the 
settings from and then press <Enter>. 

 
Changing the Current Company 

 
You should save any changes you wish to keep before changing 
companies.  To change the current company you are working on 
click on Select and the Company.  A list of companies will now be 
displayed.  Double click on the company you wish to edit next.   

 
Saving Changes 

 
To save your changes click on File and then Save or press the 
<ALT> key followed by the <S> key. 

 
Exiting the Hours of Operation Form 

 
To exit the Hours of Operation Form click on File and the Exit or 
press the <ALT> key followed by the <E> key. 

 

Recording Prompts 
 

Recording the prompts that you set up in the Hours of Operation 
form requires that the Atlas WAV be attached to a telephone 
system. 

 
To start recording the prompts select a channel that has a single 
line port attached to it by clicking on the window for that channel. 

 
After selecting an active channel click on Prompts and the 
Greetings.  The following screen should now appear. 
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Figure 3-3: System Greetings Form 

 
To begin recording greetings enter an extension number of a 
telephone nearby that you can use to record the prompts in the 
phone number field.  Then click on File and the Dial.  The system 
will call the extension that you entered into the phone number 
field, while the phone is ringing pick up the handset and say hello.  
You should notice that the text on the screen will change from 
gray to black.   

 
Once the text has changed from gray to black double click on the 
company that you wish to record the greetings for in the left hand 
column.  The greetings you have set up in the Hours of Operation 
Form will now appear in the right hand column.  Click on the 
greeting you wish to record and then click on Greeting and the 
Record.  You will now hear beep.  After the beep start recording 
the prompt.  Once you have recorded the prompt the system will 
play the recording back to you to verify that it sounds correct.  If 
you approve of the recording continue for any other prompt that 
needs to be recorded.  If you do not like the recording simply click 
on record again to rerecord it. 

 
After you have finished recording all of the greetings Click on File 
and then Exit to close the System Greetings Form. 

 

Defining Main Greeting Audio Options 
 

In your main greeting prompt(s) you may want to give the caller 
single digit dialing options, for example dial 1 for sales or dial 2 
for shipping.  These options can very by company. 
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The screen to define the main greeting audio options can be 
accessed by Clicking on Edità Switch Integration, Edit – In Band 
– Main Greeting.  The following screen will then open. 

  

 

Figure 3-4: Main Greeting Caller Options 

 
See Chapter 4 (Setting up a Basic WAV System) for detailed 
information on adding dialing options to the Main Greeting. 

 



 
 
 
 
 

4 
 Setting Up a BASIC  
 Atlas WAV System 

 
 
 

C H A P T E R  
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This chapter will provide step by step instructions to set up a basic 
Atlas WAV Voice Mail / Auto Attendant system.  You will need 
to determine several items and operations prior to programming 
your Atlas WAV system.  It would be very helpful for you to write 
these things down so that you can see how you want your system 
to operate: 

 
 

BASIC INFORMATION REQUIREMENTS 
 

• Mailbox Numbers (should match your extension numbers) 
• List of Mailbox Subscribers (owners) & extension numbers 
• Hours of operation (Day / Night / etc.) 
• Company Greeting (what your callers will hear when the Auto  

Attendant answers)  You may need several: 
• Normal morning greeting 
• Normal afternoon greeting 
• Closed for business greeting 
• Weekend greeting 

• Caller Options (what you will allow your callers to do from     
the Company Greeting) 

• Dial an extension 
• Call the Operator 
• Access a company directory 
• Access pre-recorded information (directions, business 

hours, promotions, etc.) 
 
 

BASIC WAV SETUP 
 
 
The Atlas WAV system is a very full featured Voice Mail / Auto Attendant system 
with a very complete set of features to match almost any customer requirement.  In 
many cases a basic system is all that is required and the WAV can be set up as a 
basic system very quickly and with very little programming.  Simply: 
 

• Set up The Operator 
• Set up your mailboxes 
• Set up your Hours of Operation 
• Record your company greetings 
• Set up dialing options in your main greeting 
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INTEGRATING THE WAV TO THE ATLAS PHONE 
SYSTEM 
 

You need to make all the connections between the Atlas WAV and 
the Atlas phone system first.  Next you need to do the appropriate 
programming in the phone system.  When this is done you will 
have “integration” between the two systems. 
 
Please see the Atlas WAV Quick Start Guide (Section 2) for 
detailed instructions on the following: 
 
• Connect the SMDI (integration) cables to the appropriate 

COM port of the SMDR unit of your Atlas phone system and 
to the COM 1 port of the Atlas WAV. 

• Pay attention to the DIP Switch settings on the SMDR unit (or 
card) that are required for proper WAV operation and 
integration. 

• Connect the Single Line Ports to be used for Voice Mail from 
your Atlas phone system to the Voice Card ports on the back 
of the Atlas WAV. 

• Be aware that the single line ports used must observe the 
following order:  Port 2 must be a higher numbered port than 
port 1, port 3 must be a higher numbered port than port 2, etc. 

 
 
 

PROGRAMMING THE ATLAS PHONE SYSTEM FOR 
WAV OPERATION 
 
 

You must program the Single Line Ports used for the WAV to be 
defined as Voice Mail Ports and they must be set up in a Station 
Hunt Group for ease of operation.  Determine if you want the 
WAV to be the primary answering device for your calls or 
whether it will be a backup to a live operator and program the 
ringing assignments accordingly. 
 
Please see the Atlas WAV Quick Start Guide (Section 2) for 
detailed instructions on the following: 
 
• VOICE MAIL PORTS 

• Each of the Single Line Ports used for the WAV must be 
defined in their class of service as a Voice Mail Port.  (Set 
to YES) 

• It is very important to make sure that all other ports in the 
Atlas phone system are not defined as Voice Mail Ports 
(Must be set to NO) 

 
 

¤Note:  
Make sure that 
each successive 
port is a higher 
numbered port 
than the previous 
port. 

¤Note:  
If ports not used 
in the WAV are 
set to “Voice 
Mail Port” then 
integration will 
not work 
properly. 
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STATION HUNT GROUP 
• Select the appropriate station hunt group to be used for the 

Atlas WAV 
• Program all of the Single Line Ports used for the WAV into 

this station hunt group 
• You may program one of the flexible keys on the Atlas 

keyphones to be a “one button” access to the WAV if desired. 
 
 
RINGING ASSIGNMENTS 
• Direct Ringing 

• Program Direct Ringing if you want the WAV Auto 
Attendant to answer all incoming calls immediately. 

• To have a live operator serve as backup program the 
operator station(s) for delayed ringing. 

• Delayed Ringing 
• Program Delayed Ringing if you want the WAV Auto 

Attendant to answer only after calls have been ringing for 
a pre-determined period of time 

• In this scenario the live operator would be programmed to 
ring immediately on incoming calls. 

 
 

ENTERING PROGRAMMING (SYSTEM 
ADMINISTRATION) 

 
With the WAV installed and powered up you should be at the 
main screen as shown in Fig. 4-1: 
 

Figure 4-1:  WAV Main Screen 
 
 

 
 

¤Note:  
If you have more 
than 4 ports, 
those ports will 
also show up as 
individual 
channels. 
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Once you are at the WAV Main Screen you must Log On to the 
system as system administrator.  Using your mouse, “click” on 
File – Log – On as shown in Figure 4-2. 
 

 
Figure 4-2:  Logging On 

 
 
 
The WAV will then ask for your password.  See Figure 4-3.   
Enter “install”.  This is the default password.  When the correct 
password is entered the WAV will tell you that you have system 
access.  You may now proceed with the necessary programming to 
set up your system. 

 
Figure 4-3:  Entering Password 

 
 

SET UP THE OPERATOR 
 

You should always have an operator programmed in the Atlas 
WAV.  When the Auto Attendant answers the incoming call and 
also when an outside caller leaves a message in a mailbox, many 
times they need to be able to dial “0” and be transferred to a live 
operator.  All mailbox owners including the Operator are called 
“subscribers” in the Atlas WAV. 
 

:Screen Path: 
Select: 
• Fileà 
• Logà 
• ONà 
• Enter password (install) 

when requested 
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From the Main Screen select Edit – Subscriber as shown in Figure 
4-4.  Then the Select Subscriber screen (Figure 4-5) will open and 
will show existing subscribers (if any) and their extension / 
mailbox numbers. 
 
 

 
Figure 4-4:  Edit Subscriber 

 
 

 
Figure 4-5:  Select Subcriber Screen 

 
 
You may select one of the existing subscribers to edit their 
mailbox by “double clicking” on that subscriber.  To enter a new 
subscriber simply select the close button at the upper right corner 
of the Select Subscriber screen.  A blank Subscriber Setup form 
(Figure 4-6) will open and you can enter information for a new 
subscriber.  You must begin by clicking File – New. 
 
 
 
 

¤Note:  
When setting up a 
Subscriber or 
Department box 
use the following: 
Subscriber Setup 
Type Menu 
Select Menu 
Device Setup 
Activate Menu 
Message Center 
Call Control Form 
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Figure 4-6:  Subscriber Setup 

 
 
Enter OPERATOR as First Name, (no last name) and enter 
primary extension (extension number).  Then choose Select and 
check  “as Operator”  (Figure 4-7).   
 

 
Figure 4-7:  Select “As Operator” 

 
 
Next choose Type and you will see that Operator is automatically 
set as a Department (Figure 4-8).  Operator is set as a Department 
because there is no last name entered.   
 

 
Figure 4-8: Set Type as Department 

 

¤Note:  
When you enter 
any new 
subscriber you 
must begin by 
clicking File – 
New and then 
entering the 
information. 



Atlas WAV Chapter 4                                                                                                Page 8 

When this is entered select File - Save (Figure 4-9)and the WAV 
will automatically enter the rest of the information on the 
Subscriber Setup form. (Figure 4-10) 
 
 

 
Figure 4-9:  File – Save 

 

 
Figure 4-10:  Subscriber Setup – Operator 

 
 
The PIN number is the mailbox Personal Identification Number 
(password) that is entered via the touch tone pad of the telephone.    
The default PIN is 123.  The Password shown at the bottom of the 
form is a verbal password spoken by the mailbox owner only if the 
voice recognition option is ordered. 
 
 
When you enter File – Save you will hear “Changing office 
extension to primary extension 100”.  The WAV automatically 
sets up the Device Setup (Figure 4-11) for your office extension. 
 
If your subscriber does not have any additional communications 
devices – such as pagers and cell phones – then you do not need to 
do anything  else with the Device Setup form. 
 

¤Note:  
To make your 
changes permanent 
you must “click”  
File – Save.  If you 
close a form or 
screen without 
doing this, your 
changes will not be 
made. 
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Figure 4-11:  Device Setup 

 
 
If the installation has a general company fax machine then this 
fax machine must be associated with the Operator. The general fax 
is used to receive a fax whenever fax tone is received on an 
incoming line.  This device is used whenever fax tone is detected 
by the Auto Attendant.   This information is entered in the Device 
Setup – Operator screen. 
 
Begin by clicking File – New (Figure 4-12). 
 
 

 
      Figure 4-12 
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Enter FAX in the Label field.  Enter the Single Line Port 
Extension Number connected to the Fax machine in the Number 
field.  Enter FAX MACHINE in the Prompt Field.  (Figure 4-13) 
Then select Define As and define the device as a FAX device.  
(Figure 4-14) 
 
 

 
            Figure 4-13:  Operator Fax Machine 
 
 

 
                 Figure 4-14:  Define as Fax Device 
 
 
Select File – Save  to save the entries.  Your screen will appear as 
in Figure 4-15. 
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               Figure 4-15:  FAX Device Saved 
 
 
For explanations of the Activate Menu, Message Center Menu and 
Call Control Form see Setting Up Subscriber Mailboxes. 
 
 
 
 

SET UP SUBSCRIBER MAILBOXES 
 
 
 

Subscriber and Department boxes can be used for the following: 

• Record and store messages from both inside and outside 
callers. 

• Make and send messages to other box owners. 

• Give a copy of a message to another box owner. 

• Notify a box owner of newly received messages 

• Transfer a call to an extension. 

• Provide alternate call handling if an extension is busy or 
doesn’t answer. 

• Forward callers to other subscribers automatically. 
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You may either program an existing box or create a new box.  
When you select Edit - Subscriber a list of all boxes currently in 
the system is displayed on the screen.  At this point you should 
either select one of the subscribers listed or select the close button 
on the top right corner of the list to create a new subscriber.  To set 
up and customize a subscriber box, use the following forms and 
menus.  The only difference between Subscriber and Department 
Boxes is that Department Boxes only allow for First name while 
Subscriber boxes allow for First and Last name. 

 
• Subscriber Setup 
• Type Menu 
• Device Setup 
• Activate Menu 
• Message Center Menu 
• Call Control Form 

 
You can setup each subscriber basically the same way as the 
Operator.  Start with the Subscriber Setup form as in Figure 4-6 
and enter the subscribers first name, last name and extension 
number.  See figure 4-16. 

 
                          Figure 4-16:  New Subscriber 
 
When you set up a subscriber mailbox (first & last names) the 
WAV will automatically set the type as subscriber.  You can click 
on Type to verify this.  (Figure 4-17) 
 

 
             Figure 4-17:  Type – Subscriber 

¤Note:  
When you enter 
any new 
subscriber you 
must begin by 
clicking File – 
New and then 
entering the 
information. 
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Then, as always, click File – Save to save your changes.  When 
you do this the WAV will automatically fill in the rest of the 
information in the New Subscriber Form (Figure 4-17) and will set 
up the Office Extension (Figure 4-18).   
 
 

 
    Figure 4-17 

 
 
 

 
 Figure 4-18:  Office Extension Setup 
 

 
 
 
 
The WAV will automatically set up some default capabilities for 
the mailbox that can be seen in the Activate Menu and the 
Activate - Message Center Menu.   (Figure 4-19 ,4-20 & 4-21) 
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              Figure 4-19:  Activate Menu 

 
 
When the Activate Menu is opened (Figure 4-19) it will show the 
default options that are active for the mailbox.  These options have 
a check mark by them.  Get Callers Name  will ask the incoming   
caller for their name:  “May I say who is calling?”.  Personal 
Greeting  will play the personal greeting the mailbox owner has 
recorded when the caller reaches the mailbox. 
 
Message Center        Will open up the Message Center Menu 
 
Vax System       Will open up the Vax System Menu. 
  (Optional Feature) 
 
Auto Station Log On       will open up the following menu: 
 

 
                       Figure 4-20:  Auto Station Log on 
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Auto Station Log on (Figure 4-20) shows the default as Direct 
Access.  When this is checked the mailbox owner can get into the 
mailbox without entering a password.  To require a password 
simply check Request PIN.  When the mailbox owner accesses the 
mailbox  the message “Please enter your PIN Number” will be 
heard and the PIN Number must be entered before the mailbox can 
be entered. 
 
 
Next you can open the Activate – Message Center Menu and you 
will see the options that are enabled in default:  (Figure 4-21) 
 
 

 
                   Figure 4-21: Activate Message Center Menu 
 
 
The options shown with a check mark in the Activate Message 
Center Menu are those enabled in default.  It is important that the 
top item – Activate – is checked (it will be by default).  If it is not 
checked then callers will not be able to leave a message for the 
mailbox owner.  The default settings will be suitable for most 
general applications 
 
See Chapter 7 for a description of all of the options related to the 
Subscriber Setup screens. 
 

 
 
 

 
 
 

¤Note:  
Activate MUST 
be checked in the 
Message Center 
Menu for the 
mailbox to be 
able to take 
messages. 
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                               Figure 4-22:  Gender Menu 
 
The Gender Menu will allow you to select whether the subscriber 
is male or female.  This is used in the phrases such as “Please hold 
while I try his cell phone” or “Would you like me to try her cell 
phone?” 
 
Some subscribers, such as outside salesmen, would like to be 
notified when a message is left in their mailbox.  The most 
common is to have the WAV call their cell phone and let them 
know that they have a message.  This can be done very simply 
through the Device Setup screen.  (Figure 4-23) 
 
 

 
                    Figure 4-23:  Device Setup 
 
Figure 4-23 shows the subscriber with two devices associated with 
his mailbox.  One is the office phone and the other is the cell 
phone.  The cell phone is set up by going through the following 
steps after opening up the Device Setup screen: 
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• File – New 
• For Label – Type:  Cell 
• For Number – Type the Cell Phone Number 

(Do not enter 9 for outside line access) 
• For Prompt – Type Cell Phone 
• Transfer Type – Select Trunk 

 
 
• Define As – Select Cell Phone 
 

 
• Message Delivery – Inactive  (Default) 
 

 
Without changing the default Message Delivery there would 
be no call to the cell phone when a message is left in the 
mailbox.  You must change this to active and then set the 
notification times and the days to be active. 
 

• Message Delivery – Active 
 

 
This example shows Message Delivery active Monday 
through Friday from 8:30 AM until 5:30 PM.  The WAV will 
retry 3 times with 15 minutes between attempts. 

 

¤Note:  
Message Delivery – 
Inactive will light 
the Message 
Waiting Light on 
the Office Phone 
but will not call the 
cell phone 
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SET UP YOUR HOURS OF OPERATION 
 

 
The Hours of Operation form allows you to define different 
greetings for different days, different times of day and different 
companies. 

 
To open the Hours of Operation box from the main screen select 
Edit - Hours of Operation.  The following form should now be on 
the screen. 

  

 
                         Figure 4-24: Hours of Operation Form 
 
If the WAV serves more than one company use Select – Company 
and then double click on the company you wish to program: 
 

 
Figure 4-24 above shows the Hours of Operation schedule for 
Monday.  There can be up to 6 different time periods defined for 
each day.  The “Prompt to Play” section shows the prompt (or 
combination of individual prompts) that will be played when the 
Auto Attendant answers the incoming call during the time periods 
indicated.   
 
Each prompt must consist of one word or more than one word 
connected by the “_” character.  In Figure 4-24 the Lunch time 
prompt is actually 3 prompts tied together:  Good_Afternoon plus 
Welcome plus Lunch_Hours.  This will allow you to record a 
particular prompt once but be able to use it in combination with 
other prompts.  As in the above the prompt “Welcome” is used in 
all time periods but only has to be recorded once. 
 

¤Note:  
If you have more 
then one company 
defined in the 
system you will 
have to select the 
company before the 
Hours of Operation 
form will appear. 
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In Figure 4-24 above the Evening Level is not active.  To make it 
active you must click on the button “Evening”.  Clicking on an 
active button will make it inactive.  The only time periods that you 
can program are the “To” periods.  When a time is entered in a 
“To” period it is duplicated in the next active “From” period.  
Therefore if the Evening period was activated then the Evening 
“From” period would automatically be set at 5:30 PM (from the 
Afternoon “To” period) and whatever was entered in the Evening 
“To” period would automatically be entered in the Closed “From” 
period. 
 
To select a different day of the week to program then click on Day 
of the Week and select the day you need. 
 
 

 
 
In most cases Monday through Friday will all be programmed with 
the same prompts.  If this is the case you may simply copy one 
day’s information to another.  For example:  Select Day of Week 
and check Tuesday.  Then select Copy From and select Monday.  
This will automatically duplicate all of the Monday Hours of 
Operation information to Tuesday. Then select Day of Week and 
check Wednesday.  Then select Copy From and select Monday 
again.  Do this for all days that are going to be the same. 
 
 

 
 
 
 

¤Note:  
To make your 
changes permanent 
you must “click”  
File – Save.  If you 
close a form or 
screen without 
doing this, your 
changes will not be 
made. 
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RECORD YOUR COMPANY GREETINGS 
 
Recording the prompts that you set up in the Hours of Operation 
form requires that the Atlas WAV be attached to a telephone 
system.  To start recording the prompts select a channel that has a 
single line port attached to it by clicking on the window for that 
channel. 
 
After selecting an active channel click on Prompts and then 
Greetings.   
 

 
The following screen should now appear. 

 
                        Figure 4-25:  System Greetings 
 
The System Greetings screen appears and the existing greetings 
listed are shown in grey. To begin recording greetings enter an 
extension number of a telephone nearby that you can use to record 
the prompts in the “Ext” field.  Then click on File and then Dial.   
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The system will call the extension that you entered into the “Ext” 
field.  While the phone is ringing pick up the handset and say hello 
until you notice that the text on the screen changes from gray to 
black.   
 

 
 
Once the text has changed from gray to black double click on the 
company that you wish to record the greetings for in the left hand 
column.  The greetings you have set up in the Hours of Operation 
Form will now appear in the right hand column.  Click on the 
greeting you wish to record and then click on Greeting and then 
Record.   
 

 
 
You will now hear beep and a window will open up indicating that 
you should start recording.   
 

 
After the beep start recording the prompt.   
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Once you have recorded the prompt the system will play the 
recording back to you to verify that it sounds correct.  If you 
approve of the recording continue for any other prompt that needs 
to be recorded.  If you do not like the recording simply click on 
record again to rerecord it. 
 
After you have finished recording all of the greetings Click on File 
and then Exit to close the System Greetings Form. 
 
 
SUBSCRIBER PROMPTS 
 
 
When you set up your subscribers and closed the Subscriber Setup 
screen, you probably got a message over the speakers that said:  
“You have <number>  subscriber prompts to be recorded”. 
 
You record these new subscriber prompts using the same 
procedure that you used for recording your greetings.  Select 
Subscriber Prompts: 
 

 
 
The Subscriber Prompt screen will appear. 
 

 
Follow the same procedure as you did for recording your 
Company  Greetings. 
 

• Enter Extension number in Phone Number area 
• File – Dial / Answer and say “Hello” 
• Click on Name prompt 
• Prompt – Record  /  “beep” / Then record prompt 
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DIALING OPTIONS IN THE MAIN GREETING 
 
 
Before setting Dialing Options in the Main Greeting you should 
look at the default settings in the System Signaling section.  These 
default settings are global, meaning they are in effect anywhere in 
the WAV system. 
 
By looking at these you will reduce the number of entries that you 
will have to make in your Main Greeting.  
 
The screen that shows System Signalling can be accessed from the 
main screen by Clicking on File - Edit – Switch  Integration, Edit 
– In Band – System Signalling.   
 

 
 

 
 
When the screen appears then double click on the line                
“00 SYSTEM – General System Interface”.  This will show  all of 
the In Band Signaling Codes that are already programmed in the 
WAV. (Figure 4-26)  These codes are available throughout the 
WAV.  If you need to change any of these simply double click on 
the particular code you wish to change and modify the entries that 
appear in the upper part of the screen. 
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          Figure 4-26:  General System Interface 
 
This screen shows what can be dialed by the caller and what action 
will take place when that digit(s) is dialed.  For example:  If the 
caller dials the pound key twice (##) the WAV will respond with 
“Using your touch tone pad, please enter the first few letters……”.  
Or if the caller dials “0” they will be transferred to the Operator.   
 
All of the entries shown in the General System Interface are 
available in the Main Greeting.  If there are additional items you 
would like to have available in the Main Greeting then you can 
enter these for the Main Greeting as shown below. 
 
 
In your main greeting prompt(s) you may want to give the caller 
single digit dialing options, for example dial 1 for sales or dial 2 
for shipping.  These options can vary by company. 
 
An audio menu is a recorded message that verbally gives a caller 
options associated with keypad numbers.  Pressing the key 
associated with the option performs the action described by the 
option. 
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The following is an example of an audio menu that can be used as 
the Main Greeting. 

 
 
 
 
 
 
 

 
 
 
 
The entries for Company Directory and for Operator are already 
present in the General System Interface so they are already 
available.  Sales and Shipping need to be entered in the Main 
Greeting. 
 
 
 
The screen to define the main greeting audio options can be 
accessed from the main screen by Clicking on File - Edit – Switch  
Integration,  Edit – In Band – Main Greeting.   
 
 
 

 
 
 
 

 
 
 
 
 
 
 

“For Sales, Press 1” 
“For Shipping, Press 2” 

“For a Company Directory, Press ##” 
“For an Operator, Press 0” 

¤Note:  
Be sure that 
you record the 
dialing options 
in your main 
greeting prompt 
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The following screen will then open: 

 
 
 
 
Next double click on “Master Record” so that it is highlighted and 
then click File – New to begin your first entry:  “For Sales, Press 
1”.  In the field “Tree Entry” enter the digit that the caller will dial 
– in this case the digit 1. 
 
In the lower right hand box are listed the different possibilities that 
can happen when the “Tree Entry” digit is dialed.  Double click on 
“Goto Subscriber”.   
 
The Select Subscriber window (Figure 4-5) will open up.  Double 
click on the subscriber that you want to be dialed when the caller 
presses “1”.  In this example you double clicked on Sales. 
 
Then click File – Save.  Double click on Master Record and you 
will see that “1             Goto Subscriber SALES” has been added. 
 
Next click File – New / enter “2” in the Tree Entry field / double 
click on “Goto Subscriber” / select SHIPPING (double click on it) 
and then click File – Save. 
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Double click on Master Record and  you will see a screen as 
shown in Figure 4-28. 
 

 
            Figure 4-28:  Main Greeting Call Control 
 
 
This chapter allowed you to set up your Atlas WAV in a manner 
that will fit most of your applications.  The next chapter will 
present more advanced features that are available to be 
programmed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 
 
 
 

5 
 Using Advanced 

 WAV Features 
 

C H A P T E R  
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In Chapter 4 you used Subscriber and Department mailboxes in 
setting up a basic WAV system.  There are additional types of 
mailboxes that can be used to enhance the WAV even further. 
 
The types of boxes available in the WAV are: 
 

• Subscriber 
• Department 
• Client Box 
• Information Box 
• Group Box 
• Uniform Call Distribution Box 
• Visual Tree Box 
 

 
 

CLIENT BOX 
 
The Client Mailbox is currently not available.  It will be available 
in future releases of the Atlas WAV. 
 
 
INFORMATION BOX 
 
Information boxes are used to provide information to the caller.  
This is in the form of a pre-recorded message.  The message is 
recorded as the personal greeting of the Information Box.  The 
information box can then transfer a caller to an extension after the 
message is heard and/or take a message from the caller. 
 
You initially set up an Information Box in much the same manner 
as you do for a Subscriber Box using the following: 
 

• Subscriber Setup 
• Type Menu 
• Activate 
• Message Center 
• Call Control Form 

 
These are not all required but are available if needed. 
 
 
From the Main Screen select Edit – Subscriber 
From Subscriber Setup select File – New 
First Name – enter Company Directions 
Primary Ext. – enter a “fake” ext. number 
 (this will become the box number and does not have  

 to be a valid PBX extension) 
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Enter Type – Information  Box 
 

 
 
Enter File – Save 
 

 
 
When an incoming caller dials the Information Box number they 
will hear the message recorded as the personal greeting and then 
will hear the message:  “How may I direct your call?” 
 
Many times an Information box(es) is used in a Visual Tree. 
 
 
GROUP BOX 
 
 
Group Boxes are used to distribute messages among a group of 
two or more boxes.  The group box may contain active subscribers 
and/or departments. 
 
These types of  boxes are typically for customer service 
department,  sales department,  etc. or in any situation where there 
is a need to be able to distribute the same voice message to many 
(two or more) subscriber boxes.  For example: one voice message 
could be recorded in a sales box.  This message will be duplicated 
in every box assigned to the sales box. 
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For this example there will be a Sales Group Box with three sales 
person’s mailboxes included. 
 
Set up a Group Box using the following forms and menus: 
 

• Subscriber Setup 
• Type Menu 
• Message Center 
• Select Subscriber form 

 
From the Main Screen select Edit – Subscriber 
From Subscriber Setup select File – New 
First Name – enter Sales Group Box 
Primary Ext. – enter a “fake” ext. number 
 (this will become the box number and does not have  

 to be a valid PBX extension) 
Enter Type – Group Msg. Box 
 

 
 
 
 
Enter File - Save 
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Enter Edit – Group Message Box 
 

 
 
The Subscriber Group Selection Box will open.  In this box there 
is a list of all subscribers in the right hand column (Selection List).  
Double click the subscribers that you want to move to the left-
hand column (Active Group).  Those listed in the active group are 
the subscribers that will get messages left in the Sales Group Box. 
 

 
 
Enter File – Save in the Subscriber Group Selection Box 
 

 
In this example anyone calling in and dialing “510” will get the 
recorded name in mailbox 510 (Sales Group Message Box as an 
example) and they can leave a message.  This message will be 
recorded in each mailbox that is in the Subscriber Group Selection 
Box Active Group (Donald Duck, James Dean and Operator) 
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UNIFORM CALL DISTRIBUTION BOX 
 
 
Uniform Call Distribution boxes are used to send callers to a 
group of two or more subscribers using a circular hunt method.  
This type of box is useful where you have a department with 
several people (a sales group for example) and you wish to have 
the WAV evenly distribute calls to the people in that department. 
 
For this example there will be a UCD Box that will distribute 
incoming calls to three sales people. 
 
Set up a Uniform Call Distribution Box using the following forms 
and menus: 
 

• Subscriber Setup 
• Type Menu 
• Activate Menu 
• Select Subscriber form 

 
From the Main Screen select Edit – Subscriber 
From Subscriber Setup select File – New 
First Name – enter Sales UCD Group   
Primary Ext. – enter a “fake” ext. number 
 (this will become the box number and does not have  

 to be a valid PBX extension) 
Enter Type – Uniform Call Dist. 
 
 
 

 
 
 
Next open the Activate Menu in the Subscriber Setup and click on 
any features that you want to activate. 
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Enter File – Save 
 

 
 
Enter Edit – Uniform Call Distribution 
 

 
 
The Uniform Call Distribution Selection Box will open.  In this 
box there is a list of all subscribers in the right hand column 
(Subscriber List).  Double click the subscribers that you want to 
move to the left-hand column (Active Group).  Those listed in the 
active group are the subscribers that will get calls directed to the 
UCD Sales Group. 
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Enter File – Save in the Uniform Call Distribution Selection Box 
 

 
 
To make this UCD group available to incoming callers through the 
WAV you need to set up a dialing option in the Main Greeting.  
Do this  the same way you did in Chapter 4: 
 

• From the Main Screen:  File - Edit – Switch 
Integration, Edit – In Band – Main Greeting 

• Double click on Master Record 
• Enter “4” in the Tree Entry field 
• Double click on “Goto Subscriber” 
• The Select Subscriber window will open up.  Double 

click on the subscriber you want to be called when the 
WAV caller dials “4”. 
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• Then click File – Save 
 

 
 

• Then double click on Master Record and you will see 
the following entries: 

 

 
 
In this example anyone calling in and hearing the main greeting 
will be transferred to the UCD Sales Group when they dial “4”. 
 
 
VISUAL TREE BOX 
 
 
Visual Tree Boxes allow you to set up a multiple level prompt.  
The system will play a pre-recorded audio menu offering callers 
options on how their call will be directed.  The audio menu is 
recorded as the name in the Visual Tree Box.  The Visual Tree 
Box allows you to have dial options for several different types of 
system functions. 
 
In this example there will be a Visual Tree Box called Company 
Information.  The caller will have the option to press 1 for 
directions, press 2 for store hours or press 0 for the Operator.  
Directions (1) and Store Hours (2) are each an Information Box 
that was previously programmed and recorded.  (0) will transfer 
the call to the Operator. 
 
Set up a Visual Tree Box using the following forms and menus: 
 

• Subscriber Setup 
• Type Menu 
• Activate Menu 
• Select Subscriber form 

 
 

 
From the Main Screen select Edit – Subscriber 

¤Note:  
Be sure to record 
“Dial 4 for…….” 
in your main 
greeting to inform 
callers 
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From Subscriber Setup select File – New 
First Name – enter Company Information   
Primary Ext. – enter a “fake” ext. number 
 (this will become the box number and does not have  

 to be a valid PBX extension) 
Enter Type – Visual Tree 
 

 
 
Enter File – Save and it will show the following: 
 

 
 
Enter Edit – Visual Tree 
 

 
 
This will bring up the Visual Tree Interface Screen 
Double click on the Master Record 
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Then click File – New 
Enter “1” in Tree Entry 
Double click on “Goto Subscriber” 
 (This will open the Subscriber Selection screen) 
 
 

 
 
 
Double click on CO DIRECTIONS 
Then click File – Save 
Then click File – New 
Enter “2” in Tree Entry 
Double click on “Goto Subscriber” 
Double click on OFFICE HOURS 
Then click File – Save 
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Then double click on Master Record and you should see : 
 
 

 
 
 
Dial “0” for the Operator is already valid from the General System 
Interface Master Record.  (These are valid in any menu) 
 
Reminder: 
 

• Record in Personal Greeting of Information Box 
• Record in Name of Visual Tree Box 
• Record the dialing options in the Main Greeting 

 
 

 
 
 
 
CALL CONTROL 
 
The Call Control window is available from the Edit menu of the 
Subscriber Setup window.  The Call Control window gives you 
options on Message and Call Delivery for the current subscriber.  
Call Control also allows you to set the message aging and 
maximum message length for each subscriber. 
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From the Subscriber Setup window click on Edit – Call Control. 
 

 
 
This will bring up the Call Control window. 
 

 
 
• Escalation Messages To will put a copy of a message in 

another subscribers mailbox after “X” minutes if this 
subscriber does not retrieve that message.  If the After ___ 
Min. setting is left at “0” the message will escalate 
immediately. 

 
• Forward All Messages To will take the message and put it in 

the assigned subscribers mailbox.  It will not leave a copy in 
this mailbox. 

 
• Forward All Calls To will immediately forward all calls 

handled by the WAV to the assigned subscriber.  Then that 
subscriber answers the call the WAV will say:  “You have a 
call from _________”  (Incoming Caller’s Name) and then say  
“for” (Original Subscriber’s Name) and then “Connecting 
Call”. 
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To set up any of the features click on Select: 

 
This will bring up the Select Message Escalation window . 
 

 
 
Then double click on the subscriber that you want to receive a 
copy the message left in your mailbox.  When this is done the Call 
Control window will show: 
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Reminder:  You need to set the number of minutes after which the 
copy of the message will be made.  If left at “0”, the message will 
escalate immediately. 
 
When you are finished you must click on File – Save in this Call 
Control window. 
 

 
 
To remove any of the Call Control settings you must click on 
Reset and then the appropriate entry. 
 
 

 
 
When this is done the Message Escalation will be removed: 
 
 

 
 



 
 
 
 
 

6 
 Atlas WAV Main Screen 
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This chapter will describe the different areas of the Atlas WAV 
Main Screen.  This is the first screen that you will see when the 
system has completed the power up sequence. 
 
It is from this screen that you will enter your password and will 
then be able to enter programming and make any changes / 
additions to the system. 
 
 

 

THE ATLAS WAV MAIN SCREEN 
 
 

 
 

FIGURE 6-1:  THE MAIN SCREEN 
 

The Main Screen is broken down into three different dialog boxes. 
 
 

ONE MAIN DIALOG BOX 
 

• Access Databases 
• Access System Setup 
• Access Switch Integration 
• Access System Information 
• Status Window that displays system activity 

 
SCHEDULE DIALOG 
 

• Display Current Schedule Information and Control 
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CHANNEL DIALOG(S) 
 

• One for each Channel 
• Record Prompts 
• Access System Prompts 
• Access History Information 
• Access Company Based Subscribers 
• Line Control 

 
 

Within each of these dialog boxes there are pull down menus and 
sub-menus which will allow you to see settings and make changes 
in a manner consistent with typical Windows Operation. 
 
 

  

THE MAIN DIALOG 
 

 
                 FIGURE 6-2:  THE MAIN DIALOG 

 
 

The Main Dialog Box is the gateway to most of the areas you will 
be dealing with when you are setting up the WAV and when you 
are making changes in the future. 
 
The large white area below the menu bar is the status 
window.  Every action taken by the WAV or by an outside 
caller or by a mailbox owner will be shown (in real time) as 
it happens in this window.  To clear this window of all past 
activity simply double click anywhere in the window. 
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Immediately below the title bar is a menu bar with the 
following items:  File, Set, Select, Edit, View, Update, 
Restart and Schedule. 
 
The File Menu 

 
 
When you click on Log – On you will be prompted to enter 
the password. 
 

 
Enter the default password (install). 
 

File Menu 
 

MENU ITEM DESCRIPTION 
Log – On Log onto system by entering password 
Log – Off Take the system out of programming mode 

(Will automatically log-off after 4 Min. of inactivity 
Validate 
(Phone Schedules) 

Check all subscribers phone schedules for valid 
devices and times 

Clean Up 
(Deleted Messages) 

Clean up messages that have been deleted or no 
longer belong to anyone 

Prompts 
(Remove List) 

Removes list of prompts (found in Channel Dialog / 
Prompts / Subscriber) that need to be recorded 

Edit Should only be used under the direction of Key 
System US Technical Support  (See Chapter 9) 

Backup / Restore Used to make a full or database backup 
Exit Used to shut down the Atlas WAV system 
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The Set Menu 
 
 

 
 

Set Menu 
 
 

MENU ITEM DESCRIPTION 
Recognition Reset Speech Recognition default values 

Use only under direction of KSUS Technical Support 
PBX Information  
Message Waiting 
Lights 

Use this selection to set all valid message waiting 
lights on if needed 

 
 
 

The Select Menu 
 
 

 
 
 

Select Menu 
 
 

MENU ITEM DESCRIPTION 
Select Company Used to select a specific company in a multi – 

company installation 
Default Switch Set the default switch to be used with the system 
Trunk to Subscriber Used to assign specific trunks to specific companies 

in a multi – company installation 
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The Edit Menu 
 

 
The Edit Menu is used extensively in programming and 
administering the Atlas WAV system.  See Chapter 7 for 
complete detail of this menu. 

 
 

The View Menu 

 
View Menu 

 

MENU ITEM DESCRIPTION 
Subscriber Tree View all subscriber information.  Information is 

viewed in a tree like format.  Used to view such 
information as transfer schedule, devices, etc. 

System Information View system information such as number of ports, 
release date, etc. 

Schedule Log View the Schedule Log 
Compile Log Used in speech recognition option only 
SMDR Log Used to view the SMDR history log 
System History 
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The Update Menu 
 

 
 
 

Update Menu 
 
 

MENU ITEM DESCRIPTION 
Subscriber Database Rebuild speech recognition grammars.  Only needed 

when a new subscriber has been added or a 
subscriber’s “when ask for” information has been 
changed   (Speech Recognition only) 

 
 
 
 

The Restart Menu 
 
 

 
 
 

Restart Menu 
 
 

MENU ITEM DESCRIPTION 
Channels Restart the channels in a case where a channel or line 

fails to operate 
System Shut down the system and restart from the beginning.  

The system will exit and restart itself 
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The Schedule Menu 

 

 
 

Schedule Menu 
 

MENU ITEM DESCRIPTION 
Start Up Start up the schedule window after it has been shut 

down or closed out 
Shut Down Shut down the schedule window after it has been 

started up 

 
 
 
 

CHANNEL(S) DIALOG 
 
 

 
 

The Channel Menu 
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CHANNEL MENU 
 
 

MENU ITEM DESCRIPTION 
Test Recognition Used to test speech recognition on a new company 
View History Log Select to view a history log of current activity within 

the system 
Select (Operator’s 
Voice) 

Selects from a choice (if available) of operator voices 
for the channel 

 
 
 
 

The Actions Menu 
 
 

 
 
 
 

Actions Menu 
 
 

MENU ITEM DESCRIPTION 
Start Channel Used to start the channel after it has been stopped 
Stop Channel Used to stop the channel after it has been started  

This will stop all incoming calls to the channel 
On Hook Used to manually stop the channel and place it on 

hook 
Off Hook Used to manually stop the channel and place it off 

hook 
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The Prompts Menu 

 
 

 
 

Prompts Menu 
 
 

MENU ITEM DESCRIPTION 
Subscriber Edit user prompts such as first and last name or 

prompts that have been defined by the subscriber 
System Edit system prompts – These prompts are the heart of 

the system and should only be changed under the 
direction of Key System US Technical Support 

Greetings Used to edit greetings such as welcome, closing and 
company greetings 

Holidays Used to edit holiday greetings such as Thanksgiving, 
Christmas and others used in Holiday Scheduling 

 
 
 
 

THE SCHEDULER 
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The File Menu 

 
 

 
 

File Menu 
 
 

MENU ITEM DESCRIPTION 
Start Used to manually start the scheduler 
Stop Used to manually stop the scheduler 
Exit Used to exit the scheduler and shut down scheduling 

 
 
 

The Edit Menu 
 
 

 
 

Edit Menu 
 
 

MENU ITEM DESCRIPTION 
Edit (Schedule) Edit the current scheduling 
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The Log Menu 

 
 

 
 

Log Menu 
 
 

MENU ITEM DESCRIPTION 
On Activate schedule logging 
Off Deactivate schedule logging 

 



 
 
 
 
 

7 
 Atlas WAV Main Dialog 

Edit / Subscriber Menu 
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This chapter will describe the different sections available from the 
Edit Menu of the Atlas WAV Main Dialog.  Most of your time 
will be spent in this menu when you are setting up or adding to 
your Atlas WAV system. 

 

THE ATLAS WAV MAIN DIALOG 
 

 
          THE MAIN DIALOG 

 
The Main Dialog Box is the gateway to most of the areas you will 
be dealing with when you are setting up the WAV and when you 
are making changes in the future. 
 
The large white area below the menu bar is the status 
window.  Every action taken by the WAV or by an outside 
caller or by a mailbox owner will be shown (in real time) as 
it happens in this window.  To clear this window of all past 
activity simply double click anywhere in the window. 
 
Immediately below the title bar is a menu bar with the 
following items:  File, Set, Select, Edit, View, Update, 
Restart and Schedule. 
 
The Menu Bar 
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The Edit Menu 
 
 

 
 

  Edit / Subscriber 
 

 
When selecting Edit – Subscriber  you will be presented with 
a list of current subscribers.  You may double click one to 
edit or close the list to enter a new subscriber. 
 

 
 
This Subscriber Setup screen is where you enter all of the 
pertinent subscriber information for setting up the main 
extension, additional communication devices, message 
center parameters, etc. 
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        Subscriber Setup Field Definitions 
 

NAME OF ITEM DESCRIPTION 
First Name For a subscriber this field contains the first name of 

the subscriber. (Required) 
 
For a department this field contains the name of the 
department.  (Required) 

Middle Name The subscribers middle name if any. 
Last Name The subscriber’s last name. (Required) 
Primary Ext. This is the Office Extension of the subscriber.  Any 

time this is changed the office extension is also 
changed automatically. 

Pin Number A four digit number used to gain entry into the 
subscribers message center.  Access is gained at the 
main greeting prompt by pressing:  “#” + Ext. 
Number + PIN Number. 

When Ask For Defines the speech recognition used to locate the 
current entry.  Use the vertical bar to separate 
different selections to be used such as Benjamin 
Franklin or Benjamin. 

Prompt With This field is used when speaking the subscriber’s 
name, like on a transfer or no answer.  Example:  
“I’m sorry <Benjamin Franklin> did not answer.  
Would you like to leave a message. 

Password Define a subscriber’s verbal password when DTMF 
is not used.  This can be any phrase of group of 
words such as:  “My dog is black with white feet.” 

Conference Priority Define the subscriber’s priority for a conference call.  
The higher the number, the higher the priority.  

 
 

 
File Menu 
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MENU ITEM DESCRIPTION 
New Clear out the subscriber dialog and reset subscriber 

information.  To add a new subscriber. 
Save Save the current subscriber information. 
Save Name Change Save the name change when the name has been 

changed on a current subscriber. 
Delete Delete the current subscriber and reset the subscriber 

dialog. 
Delete List Select a group of subscribers to delete from the 

system. 
Duplicate 
Subscriber 

Duplicate the current subscriber information into a 
given number of subscribers. 

Exit Exit the subscriber dialog. 
Save & Exit Save the current subscriber information and exit the 

subscriber dialog. 

 
When selecting Delete List a Subscriber Deletion List will 
open and then you simply double click a name to move it 
from one list to the other. 

 
 
 

 
 

File Menu 
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MENU ITEM DESCRIPTION 
Save Deletes all subscribers contained in the Group to 

Delete list. 
Reset Clear out all subscribers listed in the Group to Delete 

list. 
Exit Exit the Subscriber Deletion List dialog. 

 
 
 
You may save time when entering a large number of new 
subscribers that all have the same feature requirements by 
using the Duplicate Subscriber dialog. 
 
 

 
 

Duplicate Subscriber 
 

NAME OF ITEM DESCRIPTION 
Starting Extension The new subscriber extension number to start with – 

such as 120. 
Increment By The number by which to increment the extension 

number – such as 5 – resulting in new subscribers 
120, 125, 130, etc. 

Number of The number of new extensions needed – for example 
10 – would create 10 new subscribers. 

OK Will create the extensions or subscribers defined. 
Cancel Will cancel the creation of new subscribers or 

extensions. 

 
 
 
 
 



Atlas WAV Chapter 7                                                                                                Page 6 

 

 
Select Menu 

 

MENU ITEM DESCRIPTION 
Subscriber Select a subscriber to be edited from a subscriber list.  

If a company has been selected then only that 
company will be displayed. 

As Operator Used to select one specific subscriber to be the 
Operator. 

Next Moves to the next subscriber  
Previous Moves to the previous subscriber 

 
 

 
Company  

 

MENU ITEM DESCRIPTION 
All Company Assign the subscriber to all companies  
Master Select a given Company only when editing or 

selecting subscribers. 
Group Assign a subscriber to a group of companies 
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Toll Restriction 
 
 

MENU ITEM DESCRIPTION 
None No Toll Restriction controlled by the WAV  
Local Call Only Subscriber restricted to local calls only by the WAV 
Internal Calls Only Subscribe restricted to internal calls only by the 

WAV 

 
 
 

Type Menu 
 
When programming a new mailbox or subscriber the Type 
must be defined.  This is done by selecting from the Type 
Menu. 
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Type Menu 

 

MENU ITEM DESCRIPTION 
Subscriber Defines the type as subscriber.  If active, then this 

entry has a first and last name for directory services. 
Client Defines the type as client.  If active, the user will 

only show up in the company wide Dial by Name 
Directory. 

Department Defines the type as department.  If active, then this 
entry will only show up as a whole name in directory 
services. 

Information Box Defines the type as information box.  If active, then 
the “Prompt With” will be automatically played and 
the call transferred as defined. 

Group Message 
Box 

Defines the type as group message box.  If active, the 
caller will be told to leave a message for the group as 
specified in the “Prompt with”.  The message is then 
sent to each person in the group box. 

Uniform Call 
Distribution 

Defines the type as uniform call distribution.  If 
active, incoming calls are routed in a circular hunt 
fashion to a group of subscribers. 

Visual Tree Defines the type as visual tree.  If active, then a user 
defined tree is used to route the caller. 

 
 
Edit Menu 
 
The Edit Menu is used to set up additional communications 
devices and to set message delivery options, call screening 
options and call routing options. 
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Edit Menu 

 

MENU ITEM DESCRIPTION 
Device Setup Edit and define all phones, faxes, pagers – any 

communication devices allowed in the system. 
Call Control Edit message and call control – such as message 

escalation, forward messages, forward calls, etc.  
Prompt Select prompts that are already recorded to be stored 

in the “prompt with” field. 
Call Screening   
Call Routing Used to define a schedule for what happens when a 

communication device is busy, does not answer or 
for message delivery. 

N / A Edit Group Message Box, Uniform Call distribution 
or Visual Tree depending on “type” defined. 

Conference This menu item is currently not active 
Personal Directory Edit Personal Directory for speech recognition “dial 

by name”. 
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Device Setup Field Definitions 

 

NAME OF ITEM DESCRIPTION 
Label The name of the device.  This name is used during 

device search and lookup. 
Number This is the physical number of the device.  Do not 

forget to add the “1” and area code to long distance 
numbers. 

Prompt This is the general description of the device and is 
used on prompting the caller on transfers and on call 
follow-me. 

Access Code Used in processing pager access.  This number is 
dialed after the pager has been called. 

Pager ID Used in processing pager access.  This number is 
dialed after the access code. 

Delay Defines the delay in minutes between the time the 
message is left and the pager notification is started. 

Rings No Answer Defines the number of rings to wait before no 
answer. 

Queuing Defines the maximum number of callers that can be 
queued on this device. 

MWL Command Used to light the message waiting light if different 
from the switch command. 

 
 
 
 

 
 
 
Call and Message Delivery Field Definitions 
 

NAME OF ITEM DESCRIPTION 
Call Delivery – All 
Hours 

Calls may be transferred to this device 24 hours a 
day / 7 days a week. 

Call Delivery - If active then the device can only be used for the 
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Active time period specified. 
From Starting time for the active device. 
To Ending time for the active device. 
Retry The number of times to try the device on a call. 
Delay The number of seconds to wait before the next retry. 
 
 

 

Message Delivery – 
Inactive 

Messages will not be delivered to any device.  
Exception:  Message waiting light will always be 
turned on at the Office Extension. 

Message Delivery – 
Active 

If active then defines the time periods when 
messages can be delivered to the device. 

From Starting time for the active device. 
To Ending time for the active device. 
Retry Number of times to try the device on a message 

delivery. 
Delay The number of minutes to wait before the next retry. 

 
 
 

 
 
 
                  Device Setup File Menu 
 

MENU ITEM DESCRIPTION 
New Create a new device.  Cleans out data fields and sets 

up default. 
Save Save the current device. 
Delete Delete the current device. 
Exit  Exit the Device Setup dialog. 
Save & Exit Save the current device and exit the Device Setup 

dialog. 
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                Device Setup Edit Menu 
 

MENU ITEM DESCRIPTION 
Prompt Brings up a list of prerecorded prompts to select 

from. 

 
 

 
         Device Setup Transfer Type Menu 
 

MENU ITEM DESCRIPTION 
Station Defines the device as an internal line or extension.  

This causes the station switch integration to be used. 
Trunk Defines the device as a trunk line or outside line.  

This causes the trunk switch integration to be used. 
Use Conference This tells the switch to use conferencing when 

transferring. 
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           Device Setup Define As Menu 
 

MENU ITEM DESCRIPTION 
Station Defines the device as a station on the switch. 
Cell Phone Defines the device as a Cell Phone. 
Fax Device Defines the device as a Fax Device.  This device is 

used when an incoming fax is sent to a subscriber. 
Voice Mail Defines the device as Voice Mail.  Used when 

transferring to another voice mail. 
Mailbox Defines the device as a Mailbox.  A mailbox is used 

when the same extension is used for several different 
people. 

Pager – Digital Defines the device as a Digital Pager.  The access 
code and pager ID are used to complete the pager 
sequence. 

Pager – Voice Defines the device as a Voice Pager.  The message 
received is played over the pager. 

Pager – Alpha Defines the device as an Alpha Pager.  This device is 
not used. 

Data Link Defines the device as a Data Link.  This device is not 
used. 

Video Phone Defines the device as a Video Phone.  This device is 
not used. 

Net Phone Defines the device as a Net Phone.  This device is 
not used. 

E-Mail Defines the device as an e-mail address.  Used when 
sending e-mail to a subscriber. 
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              Device Setup Options Menu 
 

MENU ITEM DESCRIPTION 
Call Screening Allow the subscriber to access call screening 

functions on a transfer. 
Message Waiting Tell the system this device has a message waiting 

light. 
MWL Always 
Active 

Defines that the message waiting light is always 
active.  Otherwise the MWL is active according to 
the message delivery schedule. 

Internal Paging Allow internal intercom paging for this device. 
External Paging Allow external intercom paging for this device. 
Hide Extension Hides the phone number from an incoming digit 

search. 
Do Not Disturb When active the device will not be used. 
To A Subscriber Defines this device as belonging to another 

subscriber. 
Automatic Transfer Allow this device to sequence automatically during a 

one call follow me. 
Call Queue Allow callers to be queued up until the subscriber is 

free. 
Say Description When transferring the call, say the description.  Ex:  

“Please hold while I try his Cell Phone.” 
Pass In Audio Allows the caller voice response to be played to the 

subscriber.  This is a good option for the Operator. 
Private Line Defines the device as a private line to cut down on 

response time by not saying the subscribers name on 
the transfer. 

Whisper to Me Allows the subscriber to be told who is calling while 
still on an active call. 

 

 
          Device Setup Supervision Menu 
 

MENU ITEM DESCRIPTION 
Full Supervision Provides total supervision for a transfer to this 

device. 
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Busy Supervision Provides busy supervision for a transfer to this 
device.  If the device is not busy then a blind transfer 
is done. 

Blind Transfer Provides blind transfer only for a transfer to this 
device.  Used for fax devices, etc. 

 
 
 

 
 
             Call Control Field Definitions 
 
 
 

NAME OF ITEM DESCRIPTION 
Escalate Messages 
To 

This field in conjunction with the “After___Min.” 
field provides message escalation.  

After ____ Min. This field controls the delay between the time a 
message is received and escalated to another 
subscriber. 

Forward All 
Messages To 

This field displays who messages are forwarded to. 

Forward All Calls 
To 

This field displays who calls are forwarded to. 

If Active Try This 
Phone First 

This field displays the current active phone.  It 
should be the last device the call was transferred to. 

Current Message 
Delivery 

This field displays the current message delivery 
device. 

Maximum Message 
Length 

This field shows the maximum length (in minutes) 
that will be allowed for each message. 
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Keep New 
Messages For 

The number of days to hold on to a new message 
before deleting it. 

Keep Saved 
Messages For 

The number of days to hold on to a saved message 
before deleting it. 

Keep Deleted 
Messages For 

The number of days to keep a deleted message 
before removing it from the system. 

 
 
 

 
               Call Control File Menu 
 

MENU ITEM DESCRIPTION 
Save Save the current message and call control 

information. 
Exit Exit the message and call control dialog. 
Exit Used to shut down the Atlas WAV system 

 
 
 

 
                Call Control Select Menu 
 

MENU ITEM DESCRIPTION 
First Phone When multi-devices are active, this selects the first 

device to try. 
Active Phone This is the current active device in the system.  

Normally it is the last device the caller was 
transferred to. 

Message Escalation Used to edit message escalation. 
Message Delivery Use this to select which device to deliver messages 

to. 
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Forward Messages Used to select a subscriber to post messages to. 
Forward Calls Used to select a subscriber to forward calls to. 

 
 
 

 
                 Call Control Reset Menu 
 

MENU ITEM DESCRIPTION 
First Phone Used to clear First Phone selection. 
Active Phone Used to clear Active Phone. 
Message Escalation Used to reset Message Escalation. 
Message Delivery Used to reset Message Delivery. 
Forward Messages Used to reset Forward Messages. 
Forward Calls Used to reset Forward Calls 

 
 

 
                  Call Screening Menu 
 

MENU ITEM DESCRIPTION 
Edit Define individual subscriber dial prompts available 

during call screening. 
User Defaults This will delete subscriber defined dial prompts and 

use the system default prompts. 
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         Call Screening Field Definitions 
 

NAME OF ITEM DESCRIPTION 
Master Click to make this display a master. 
DTMF Sequence This is the value the user will enter to access the 

definition (using an uppercase “X” of single digit.) 
Description This is the description of the current display. 
When Ask For Speech Recognition input – the same effect as 

DTMF sequence except is it verbal. 
Prompt With What to say for this entry. 
Current Level This is the current level.  A level can be a master or a 

slave.  Masters and slaves are grouped by using this 
field.  All records with a level 1 will be grouped 
together, etc. 

On Go To Defines where or who to go to under certain 
conditions 

Max Digits This is the maximum number of digits that can be 
entered at one time using this master.  Used to make 
response quicker. 

Seq This is the sequence number used in slaves in order 
to select the order in which they are prompted out. 
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Type of Signaling – 
Type 

This is the type of integration defined.  Type of 
signal will display the types with the current one 
highlighted.  To assign simply double click. 

Type of Signaling – 
Level 

Display the level list. 

Type of Signaling – 
Next Level 

This is the next level assigned to a slave. 

Visual Tree This shows the current masters and slaves in a simple 
tree type display.  Double click to expand. 

 
 
 
 
 

 
                Call Screening File Menu 
 

MENU ITEM DESCRIPTION 
New Reset the dialog and enter a new master or slave. 
Save Save the current display. 
Save As   

 
Load   

 
Delete Delete the current displayed item. 
Refresh Refresh the display 
Exit Exit the Call Screening dialog 
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            Call Screening View Menu 
 

MENU ITEM DESCRIPTION 
Small Icon To view the display using small icons. 
Large Icon To view the display using large icons. 
Current Level Only To view the current master level only. 

 
 
 
 
 

 
          Call Screening Prompts Menu 
 

MENU ITEM DESCRIPTION 
Edit Edit DTMF Prompts. 
Say Say “prompt with” or speech prompt. 
Play – DTMF 
Prompt 

Play the DTMF prompt. 

Play – Speech 
Prompt 

Say the speech prompt 

 
 
 
 
 

 
          Call Screening Sequence Menu 
 

MENU ITEM DESCRIPTION 
Level This activates sequencing of this level. 
All Levels This activates sequencing of all levels. 
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                    Call Routing Menu 
 

MENU ITEM DESCRIPTION 
Busy Edit the Busy Schedule.  This list defines which 

communication devices are used and in what order 
when a device is busy when being called. 

No Answer Edit the No Answer Schedule.  This list defines 
which communication devices are used and in what 
order when a device is not answered when being 
called. 

Message Edit the Message Delivery Schedule.  This list 
defines which communication devices are used and 
in what order to deliver any new messages to. 

 
 

View Menu 
 
The View Menu displays all of the subscriber information in 
a tree like display.  This is a good way to check each 
subscriber’s configuration. 
 

 



Atlas WAV Chapter 7                                                                                                Page 22 

The Detail Tree 
 
When you click on the Detail Tree the following window 
will open.  It will show configuration for that subscriber that 
has been set up in all the different areas of the Subscriber 
Setup. 
 

 
Expanded Detail Tree 

 
When you click on the boxes with the “+” in them the 
display will expand to show all the detail in that area. 
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The Activate Menu 
 
The Activate Menu contains a listing of most of the features 
that will be available for each subscriber.  These are features 
that affect the incoming call that is being handled by the 
Atlas WAV auto attendant.  The Message Center portion of 
the Activate Menu will show features that affect the 
subscriber when accessing the mailbox. 
 

 
 
 

Activate Menu 
 

MENU ITEM DESCRIPTION 
Out of Office Activate or deactivate subscriber Out of Office 

status.  If subscriber is out of office  then no call will 
be transferred. 

Announce Transfer Activate Announce Transfer.  If active the caller will 
be told who they are being transferred to.  Such as:  
“Please hold while I transfer you to Sales.” 

Get Caller’s Name Activate Get Caller’s Name.  If active, before a caller 
is transferred the caller’s name will be requested.  
“May I say who is calling?”  
 

Personal Greeting   
 

Intercom Paging Activate Intercom Paging.  If active and the 
subscriber’s phone has paging access, - on a no 
answer the caller will be asked if they would like to 
page. 
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Page on Transfer Activate Page on Transfer.  If active and the 
subscriber’s phone has paging access, the subscriber 
will be paged over the intercom as the caller is being 
transferred. 

Notify by Pager Activate Pager Notification.  If active when a new 
message is left for the subscriber and the subscriber 
has an active pager, they will be paged by the WAV. 

No Directory Entry Activate No Directory Entry.  If active, then the 
subscriber will not show up in any directory listing. 

No User Options  

 
The Activate / Message Center Menu 

 

 
Activate / Message Center Menu 

 

MENU ITEM DESCRIPTION 
Activate Activate a subscriber’s message center.  If not active, 

the caller cannot leave a message for the current 
subscriber. 

Get Caller’s 
Number 

Activate Get Caller’s Number.  If active, before 
leaving a message the caller will be asked for their 
phone number. 

Verbose Provide additional information to the subscriber 
when in the Message Center.  Such as what menu he 
or she is in.  

Quick and Dirty Provide quick access in the Message Center with the 
least number of prompts. 
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Play First Message Activate Play First Message.  When the subscriber 
enters the Message Center the first new message will 
be played automatically. 

Play Time Received Play the time a message was received when playing a 
message. 

Play Caller’s Name Play the caller’s name when playing a message. 
Exit to Main 
Prompt 

Exit to the main system prompt in place of hanging 
up when exiting the message center. 

Use Touch Tone Activate Touch Tone usage in the Message Center.  
This allows the subscriber to use DTMF prompts 
when speech recognition is active 

Confirm Delete 
Message 

Activate Confirm Delete Message.  If active, when a 
subscriber deletes a message they will be asked if 
they are sure. 

Skip Deleted 
Messages 

Activate Skip Deleted Messages.  If active, deleted 
messages will not be accessed in the Message 
Center. 

Favor Take a 
Message 

Activate a positive response to a noisy line when 
using speech recognition.  If active, on an unknown 
response then “yes” will be the default. 

Just Take a 
Message 

Activate voice mail only.  The caller is given no 
options, just requested to leave a message. 

Play Message 
Control 

Activate controls when playing a message such as 
fast forward, rewind, pause, etc. 

 
 
 
 

VAX System Menu 
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              Activate VAX System Menu 
 

MENU ITEM DESCRIPTION 
Verify Dialing If active the VAX will repeat your request to dial a 

number and ask if that is correct. 
Verify Name If active the VAX will repeat your request to dial 

“Bill Smith” and ask if that is correct. 
Key Word Spotting If active the VAX will respond to requests by “key 

words”. 

 
 

Activate Auto Station Log on 
 

 
 
 

Auto Station Log on Menu 
 

MENU ITEM DESCRIPTION 
Direct Access Activate direct message center access from an office 

extension without requesting a PIN (Personal 
Identification Number) 

Request PIN Activate direct message center access from an office 
extension after requesting a PIN (Personal 
Identification Number) 

On Hold Access If active will allow the subscriber to access their 
mailbox while they have a call on hold. 

 
 
 



Atlas WAV Chapter 7                                                                                                Page 27 

Gender 
 
 

 
Gender Menu 

 

MENU ITEM DESCRIPTION 
Male Defines the gender of the subscriber as male.  This is 

used in context when transferring a call and other 
things – For Example – “Please hold while I try his 
cell phone”. 

Female Defines the gender of the subscriber a female.  This 
is used in context when transferring a call and other 
things – For Example – “Please hold while I try her 
cell phone”. 

 
 

Say 
 
 

 
Say Menu 

 

MENU ITEM DESCRIPTION 
When Ask For Play back the “When Ask For” field 
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This chapter will describe additional sections available from 
the Edit Menu of the Atlas WAV Main Dialog.  Most of your 
time will be spent in this menu when you are setting up or 
adding to your Atlas WAV system. 

 

THE ATLAS WAV MAIN DIALOG EDIT MENUS 
 

 
 

Edit / Subscriber  (See Chapter 7) 
 
 

Edit Schedule 
 
The Edit Schedule dialog is used to setup or change schedule 
information such as – reminders, wake-up calls, voice 
messages, logs, etc. 
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System Schedule Field Definitions 
 

NAME OF ITEM DESCRIPTION 
Account Internal number assigned by the WAV system. 
Name Name of subscriber 
Type Select which type of activity required 
Priority Select priority for the activity 
Clock To set the time for the activity to occur 
Message Description of the activity that will appear in 

“System Name” area 
Retry Defines the number of attempts to try the activity 
Delay Defines the delay between retry attempts 
Current Displays information about the highlighted activity 

 
 
 
 
 
 
 

 
Schedule File Menu 

 

MENU ITEM DESCRIPTION 
New To add new schedule activity 
Save Save the current information 
Delete Delete the current (highlighted) activity 
Exit  
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System Schedule Select Menu 
 

MENU ITEM DESCRIPTION 
Subscriber Select a subscriber to be scheduled from a subscriber 

list. 
Phone Select the communications device that will be used. 

 
 
 
 

Edit / Hours of Operation 
 
The Hours of  Operation dialog is used to set when the 
company is open and closed and to select prompts for 
different hours of the day. 
 
 

 
 

Hours of Operation Field Definitions 
 

NAME OF ITEM DESCRIPTION 
Levels Click to activate or deactivate each level. 
From This is the time the level becomes active. 
To This is the time the level becomes inactive. 
Prompt to Play These are the prompts that will be played while this 

level is active. 
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Hours of Operation File Menu 

 

MENU ITEM DESCRIPTION 
Save Save the current selected list. 
Exit Exit Hours of Operation.  Click Save first or any 

changes made will not be saved. 

 
 
 
 

 
Hours of Operation Select Menu 

 

MENU ITEM DESCRIPTION 
Company Select a specific company to work on in a multi-

company installation. 

 
 
 
 
 

 
Hours of Operation Day of Week Menu 

 

MENU ITEM DESCRIPTION 
Sunday….Saturday Select the day to be displayed. 
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Hours of Operation Copy From Menu 
 
 

MENU ITEM DESCRIPTION 
Sunday….Saturday Select day to copy information from.  For example:  

Program Monday parameters.  Then select Day of 
Week – Tuesday.  Then select Copy From – 
Monday.  All of Monday’s information will be 
duplicated on Tuesday. 

 
 
 
 
 

Edit / Holiday Schedule 
 
Editing the Holiday Schedule will allow you to set up 
prompts to be played on Holidays and days closed. 
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To activate a day as a Holiday simply “click” it. 
 

 
 
 
 
 

 
 

Holiday Schedule File Menu 
 

MENU ITEM DESCRIPTION 
Exit Exit the Holiday Schedule dialog. 

 
 
 
 
 
 
 

 
 

Holiday Schedule Select Menu 
 
 

MENU ITEM DESCRIPTION 
Holiday Greeting Select a Holiday Greeting to be assigned to the 

current holiday. 
Holiday by Name Select a Holiday that has already been defined. 
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Holiday Schedule Clear Menu 
 
 

MENU ITEM DESCRIPTION 
Calendar Clear out the current month and restart. 
Holiday Clear out the current holiday and restart. 

 
 
 
 
 
 
 

 
 

Holiday Schedule Month Menu 
 
 

MENU ITEM DESCRIPTION 
Month Select the Month to work on. 
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In / Out Status 
 
The In / Out Status dialog is used to change if the subscriber 
is in or out of the office.  When the subscriber status is out of 
the office then all incoming calls through the Atlas WAV 
will not ring the phone but the caller will be asked if they 
want to leave a message. 
 
 

 
 

In / Out Status Field Definitions 
 

NAME OF ITEM DESCRIPTION 
In the Office This list contains all subscribers,  departments, etc. 

that are marked in the office. 
Out of Office This list contains all subscribers, departments, etc. 

that are marked out of the office. 

 
 
 
 
 

 
 

 
In / Out Status File Menu 
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MENU ITEM DESCRIPTION 
Save Save the current In / Out of Office Status. 
Clear All Used to clear all subscribers from the Out of Office 

list. 
Exit Exit the In / Out Status dialog. 

 
 
 

Company Database 
 
Company Database is used to edit multi-company 
installations.  It is used only if you have more than one 
company in the system. 
 
 

 
 

Company Database Field Definitions 
 
 

NAME OF ITEM DESCRIPTION 
Number This is the company number assigned to keep 

companies separate. 
Company Name This is the name of the company. 
Company Listing 
Area 

This is the list of all the current companies that are 
set up. 
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Company Database File Menu 
 

MENU ITEM DESCRIPTION 
New This is used to enter a new company to be served by 

the Atlas WAV 
Save This adds the new company to the list. 
Delete Delete the highlighted or current company 
Exit Exit the company setup 

 
 
 

Trunk Database 
 
Trunk Database is used whenever there is a need to have 
different main greetings for different trunks.  Such as when 
more than one company is being served by the Atlas WAV 
or if there is a trunk or group of trunks that need to be 
answered differently. 
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Trunk Database Field Definitions 
 

NAME OF ITEM DESCRIPTION 
Trunk This is the physical number of the trunk in the 

associated Key Service Unit. 
Company This is the company associated with the specific 

trunk. 
Company Listing 
Area 

This is the list of all the current Trunks that have 
specific companies assigned to them. 

 
 
 

 
 

Trunk Database File Menu 
 

MENU ITEM DESCRIPTION 
New This is used to enter a new trunk number to be 

assigned to a specific company 
Save This will add  the new company to the company list. 
Delete This will delete the highlighted company from the 

list. 
Exit Exit the Trunk Database dialog. 

 
 
 

InnFone 
 

The InnFone is a PC Front Desk and Call Accounting 
integrated system is an option that can be ordered with the 
Atlas WAV.  It turns the front desk into a comprehensive 
hospitality management system with guest names, full call 
accounting with surcharge and call costing capability, credit 
limits, room audits, etc.  If this option is ordered then 
clicking on the InnFone will bring up the following screen.   
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The InnFone is covered in a separate manual. 
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This chapter will describe additional sections available from 
the File - Edit Menu of the Atlas WAV Main Dialog.  Many 
of these screens should only be modified under direction of 
Key System US Technical Support. 

 

THE ATLAS WAV MAIN DIALOG FILE - EDIT MENUS 
 

 
 
 
 

File – Edit Switch Integration 
 
Switch Integration is used to set up switch signaling 
information.  This area can affect many areas of the 
operation of the Atlas WAV system and should only be 
accessed by a qualified trained technician. 
 

 
 
 
When Switch Integration is selected the following screen 
will appear: 
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Switch Integration Field Definitions 
 
 

NAME OF ITEM DESCRIPTION 
Name This is the name of the switch that the WAV is 

attached to. 
Description The description of the switch. 
MWL The button used to enable or disable message waiting 

light operation. 
MWL On The dialing sequences needed to turn on a message 

waiting from an idle line. 
MWL Off The dialing sequence needed to turn off a message 

waiting from an idle line. 
MWL All Off The dialing sequence needed to turn off all message 

waiting from a given line. 
DTMF On The length of time in 10 millisecond increments the 

DTMF tone is generated 
DTMF Off The length of time in 10 millisecond increments the 

DTMF tone is off after being generated. 
Extension Length This is the number of digits needed by the switch to 

make up an extension. 
Call Analysis Digits 
Count 

The maximum number of digits to allow when 
waiting for advanced signaling to finish.  This can 
speed up transfers but may cause a misdial. 
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Wait For The number of incoming rings to wait before 
answering the line.  This number can be set higher so 
only the Operator overflow is answered. 

Off Hook Delay This is the time period in 10 ms increments that no 
digits will be detected after going off hook.  This can 
be set higher for switches that send extra digits when 
going off hook. 

Inter-Digit Delay Defines the inter-digit delay when the WAV dials 
out.   Pre-set for SMDI integration. 

Pause The length in time in 10 ms increments for going on 
hook.  Also for dialing a “comma”. 

Trunk Access The sequence needed to access an outside line 
directly from a voice mail port.  For delivering 
messages, etc. 

Ring Delay The amount of time in 100 ms increments between 
the completion of dialing and when the first ring is 
heard. 

Ring Time The amount of time in 100 ms increments from the 
beginning of a ring to the beginning of the next ring. 

Ring On The amount of time in 100 ms increments an 
incoming ring must be present before it is considered 
a ring.  Set this value higher to eliminate short rings 
or intercom rings. 

Flash Hook The amount of time in 10 ms increments to stay on 
hook when processing a flash hook.  If the system 
drops calls try lowering this value.  If the system is 
not transferring try raising this value. 

Loop Current The minimum amount of time in 10 ms increments a 
change in loop current must stay before being 
reported. 

 
 

The following “buttons” can be turned on or off by clicking them.: 
 

Station Set on if Trunk to Station transfer is available. 
Station Conf Set on if Trunk to Station conference is availabe. 
Trunk Set on if Trunk to Trunk is available. 
Trunk Conf Set on if Trunk to Trunk Conference is available. 
Internal Paging Set on if Internal Intercom Paging is available. 
External Paging Set on if External Intercom Paging is available. 
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Station Transfer The dialing sequence needed to start the transfer of 
an incoming call to a device on the switch such as a 
station or fax. 

Station Busy The dialing sequence needed to pull back the transfer 
if the station is busy. 

Station No Answer The dialing sequence needed to pull back the transfer 
if the station does not answer. 

Answer The dialing sequence needed to connect the 
incoming call to a station. 

Rec. Conv. The dialing sequence needed to conference the voice 
mail caller and subscriber together to record the 
conversation. 

Station Conf. 
Transfer 

The dialing sequence needed to start the conference 
transfer of an incoming call to a station on the 
switch. 

Station Conf. Busy The dialing sequence needed to pull back the 
conference transfer if the station is busy 

Station Conf. 
No Answer 

The dialing sequence needed to pull back the 
conference transfer if the station does not answer. 

Station Conf. 
Answer 

The dialing sequence needed to connect the 
incoming conference call to a station. 

Station Conf. Rec. 
Conv. 

The dialing sequence needed to conference the voice 
mail caller and the subscriber together to record the 
conversation. 

Trunk Transfer The dialing sequence needed to start the transfer of 
an incoming call to a trunk on the switch. 

Trunk Busy The dialing sequence needed to pull back the transfer 
if the trunk is busy. 

Trunk  No Answer The dialing sequence needed to pull back the transfer 
if the trunk does not answer. 

Trunk Answer The dialing sequence needed to connect the 
incoming call to a trunk. 

Trunk Rec. Conv. The dialing sequence needed to conference the voice 
mail caller and subscriber together to record the 
conversation. 

Trunk Conf. 
Transfer 

The dialing sequence needed to start the conference 
transfer of an incoming call to a trunk on the switch. 

Trunk Conf. Busy The dialing sequence needed to pull back the 
conference transfer if the trunk is busy. 

Trunk Conf. 
No Answer 

The dialing sequence needed to pull back the 
conference transfer if the trunk does not answer. 

Trunk Conf. 
Answer 

The dialing sequence needed to connect the 
incoming conference call to a trunk. 
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Trunk Conf. 
Rec. Conv. 

The dialing sequence needed to conference the voice 
mail caller and subscriber together to record the 
conversation. 

Internal Paging 
Transfer 

The dialing sequence to access the internal intercom 
paging system. 

Internal Paging 
Busy 

The dialing sequence needed to pull back if the 
paging system is busy. 

Internal Paging  
No Answer 

The dialing sequence needed to pull back if the 
paging system does not answer. 

Internal Paging 
Answer 

The dialing sequence needed to pull back after the 
internal intercom page is complete. 

External Paging 
Transfer 

The dialing sequence needed to access the external 
intercom paging system. 

External Paging 
Busy 

The dialing sequence needed to pull back if the 
paging system is busy. 

External Paging 
No Answer 

The dialing sequence needed to pull back if the 
paging system does not answer. 

External Paging 
Answer 

The dialing sequence needed to pull back after the 
external intercom page is complete. 

Conference Parameters 
System Maximum 
Stations 

Maximum number of stations that can be involved in 
conferences system wide. 

System Maximum 
Trunks 

Maximum number of trunks that can be involved in 
conferences system wide. 

System Maximum 
Conf.(s) 

Maximum number of conferences that can be 
simultaneously in use system wide. 

Conference 
Maximum Stations 

Maximum number of stations in an individual 
conference. 

Conference 
Maximum Trunks 

Maximum number of trunks in an individual 
conference. 

Whisper to Me Dialing sequence needed to activate whisper page. 

 
Switch Integration Setup Symbols 

 

SYMBOL OPERATION 
X Indicates the number being dialed.  By placing an 

“X” in a field you are indicating to dial the number. 
& Perform a Flash Hook 
, Pause for the pause time indicated in switch pause 

time. 
s Wait for silence on the line or a change in condition. 
v Perform an on hook. 
^ Perform an off hook. 
r Clear out the incoming digit buffer. 
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Switch Integration File Menu 

 
 

MENU ITEM DESCRIPTION 
Save Save the switch information being displayed. 
New This will remove all entries in all fields and allow 

you to set up a new unlisted switch. 
Delete Delete the switch information being displayed  If this 

switch is the default then a new default must be 
defined. 

Select Select a different switch from the current list. 
Exit Close the switch interface dialog. 
Save & Exit Save the switch information being displayed and exit 

the switch interface dialog. 

 
 
 

 
 

Switch Integration Setup Menu 
 

MENU ITEM DESCRIPTION 
Default Set the current switch being displayed as the default 

system switch. 
Load Defaults Load the default switch information from the backup 

system. 
Save Defaults Save the current switch being displayed into the 

backup system.  DO NOT SAVE UNLESS TOLD 
TO DO SO BY TECHNICAL SUPPORT!! 
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Switch Integration Edit Menus 
 
 
The Switch Integration Edit Menus are all advanced menus.  
Call technical support for assistance in changing information 
on these menus.  
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Tone Definition Tables Definitions 

 
 

NAME OF ITEM DESCRIPTION 
Tone ID This is the tone ID number.  It should be between 

100 and 500. 
Name The Name of the tone 
Description This is the general description of the item. 
First Frequency Indicates the first frequency being detected in Hz.  

Must be defined. 
First Deviation Indicates the number of Hz the first frequency can 

change. 
Second Frequency Indicates the second frequency being detected in Hz.  

Set this to “0” if not used. 
Second Deviation Indicates the number of Hz the second frequency can 

change.  Set this to “0” if not used. 
Cadence Time On Indicates the amount of time in ms. the frequency 

will be on. 
Cadence Deviation 
On 

Indicates the amount of time in ms. the frequency  on 
time can change. 

Cadence Time Off Indicates the amount of time in ms. the  frequency 
will be off. 

Cadence Deviation 
Off 

Indicates the amount of time in ms. the frequency off 
time can change 

Count Indicates the amount times the tone must be detected 
before reporting it. 

 
 
 
 
 

 
 

Tone Definition File Menu 
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MENU ITEM DESCRIPTION 
Save Select to save current tone. 
Save As Select to save the current tone under a different 

name. 
Load Defaults Select to load the default tone table from system.  

This will replace the current tone set. 
New Select to clear tone dialog and ready for a new entry. 
Delete Delete the current tone being displayed. 
Exit Return to the switch integration dialog. 

 
 
 
 

 
 

Tone Definition Update Menu 
 
 

NAME OF ITEM DESCRIPTION 
Tones Select to update current tone tables to the system. 

 
 
 
 

Edit In Band Main Greeting 
 

 
 
 
When Main Greeting is selected it will bring up the 
following screen: 
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Main Greeting Call Control Definitions 

 

NAME OF ITEM DESCRIPTION 
Master Click to make this display a master. 
Tree Entry  
DTMF Sequence 

This is the value the user will enter to access the 
definition (using an uppercase “X” or single digit. 

Tree Entry 
Definition 

This is the description of the current display. 

When Ask For Speech Recognition input – the same effect as 
DTMF sequence except it is verbal. 

Prompt With What to say for this entry. 
Current Level This is the current level.  A level can be a master or a 

slave.  Masters and slaves are grouped by using this 
field.  All records with a level 1 will be grouped 
together, etc. 

On Go To Defines where or who to go to under certain 
conditions. 

Max Digits This is the maximum number of digits that can be 
entered at one time using this master.  Used to make 
response quicker. 

Seq This is the sequence number used in slaves in order 
to select the order in which they are prompted out.  
The order in which prompts are to be played. 
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Type of Signaling - 
Type 

This is the type of integration defined.  Type of 
signal will display the types with the current one 
highlighted.  To assign simply double click. 

Type of Signaling - 
Level 

Display the level list. 

Type of Signaling – 
Next Level 

This is the next level assigned to a slave. 

Visual Tree This shows the current masters and slaves in a simple 
tree type display.  Double click to expand. 

 
 

 
 

Main Greeting File Menu 
 
 

MENU ITEM DESCRIPTION 
New Click to reset the dialog to enter a new master or 

slave. 
Save Save current display. 
Save As To save the current display under a different name. 
Load  Load the defaults for the current group. 
Delete Delete current displayed item. 
Refresh Refresh the display. 
Exit Exit the dialog. 

 
 

 
 



Atlas WAV Chapter 9                                                                                                Page 12 

 
Main Greeting View Menu 

 
 

MENU ITEM DESCRIPTION 
Small Icon Click to view the display using small icons. 
Large Icon Click to view the display using large icons. 
Current Level Only Click to view the current level only. 

 
 
 

 
 

Main Greeting Prompt Menu 
 
 

MENU ITEM DESCRIPTION 
Edit Edit DTMF prompts – show a list of current prompts 

to select from. 
Say Click to say prompt with or speech prompt. 
DTMF Prompt Click to play DTMF prompt. 
Speech Prompt Click to play speech prompt. 

 
 
 
 
 
 

 
 

Main Greeting Sequence Menu 
 
 



Atlas WAV Chapter 9                                                                                                Page 13 

MENU ITEM DESCRIPTION 
Level This activates the sequencing of this level 
All Levels This activates the sequencing of all levels 

 
 
 
 
 

Edit  
In Band Call Screening 

In Band System Signaling 
In Band Play Message Control 

In Band Define Phone Numbers 
 
 

 
 
 
When any of these items are selected a screen similar to the 
Edit In Band Main Greeting screen will appear.  See the Edit 
In Band Main Greeting screen for Field Definitions and 
Menu explanations. 
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Switch Integration Activate Menus 
 

MENU ITEM DESCRIPTION 
Silence Disconnect If active and the system detects silence on the 

telephone line then a disconnect is assumed.  Used 
for switches that have no disconnect supervision. 

Multimedia Paging If active the sound card in the system is used when 
intercom paging is needed. 

Conference Call 
Back 

If active then the station conference or trunk 
conference will be used when processing a message 
center call back. 

Whisper to Me If active the when the called station is busy the WAV 
can activate whisper page. 

 
 
 
 
 

 
 

Activate Voice Detection Menus 
 
 

MENU ITEM DESCRIPTION 
Voice Detection - 
None 

If active (Quick, Full or Best) the voice detection is 
used when calling a person. 

Voice Detection - 
Quick 

If selected the voice connection is better with less 
bad connections but the response is slower. 

Voice Detection - 
Full 

If selected the voice detection is done quickly but 
may result in a false connection. 

Voice Detection - 
Best 

If selected the voice detection is at its best.  This 
setting can detect an answering device but the 
response time is slower and you may need to say 
“hello” twice. 
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Activate Conference Order Menus 
 
 

MENU ITEM DESCRIPTION 
Trunks First If active then trunks will be added to the conference 

first and then stations. 
Stations First If active then stations will be added to the conference 

first and then trunks. 

 
 
 
 

 
 
Switch Interface VAX Call Back On Trunk 
 
 

MENU ITEM DESCRIPTION 
Call Back On 
Trunk 

If active then the station conference or trunk 
conference will be used when processing a message 
center call back. 
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File Edit  

System Parameters 
SMDI Setup 

PMS Integration 
Comm Ports 
Recognition 

 
 
System Parameters, SMDI Setup, PMS Integration, Comm 
Ports and Recognition are menus that should not be used 
unless requested by Key System US Technical Support.  All 
of the required parameters in these menus will be set up prior 
to your receiving the Atlas WAV. 
 
 

System Signaling Definitions 
 

The Following Table defines the System Signaling In Band Signaling 
parameters. 

 

NAME DEFAULT DESCRIPTION 
Access Help  Command to Access the Help system 
Answer NO to a 
Question 

# Answer no to a question prompted to a caller or 
subscriber 

Answer YES to a 
Question 

* Answer yes to a question prompted to a caller or 
subscriber 

Ask to record a message  Ask the caller if he or she would like to leave a 
message 

Call Operator 0, 00, 911 Go to the Operator defined in the system 
Caller ID  Indicates incoming caller ID information 
Clear a subscriber  Command to clear out a subscriber message 

center of all messages 
Dial By Name  Access subscriber’s personal directory 
Dial By Name Client  Command used to access the systems client list 

for use with the VAX 
Dial By Name 
Department 

 Command used to access the system department 
list for use with the VAX 

Dial By Name  
Personal Directory 

 Command used to access the dial by name 
personal directory for use with the VAX 

Dial By Name 
Subscribers 

 Command to access the system subscriber’s list 
for use with the VAX 

Directory ## Command used to enter into Directory Services 
Do Not Use or Ignore  Command to tell the system to skip over this 

command 
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Extension XXX Defines an extension number 
External Number  Defines an external or CO type number 
Fax  Defines the extension number routing to a Fax.  

The extension can be either a subscriber’s actual 
office extension or fax extension. 

Forward Busy  Indicates that a call has been forwarded from a 
station that was busy 

Forward No Answer  Indicates that a call has been forwarded from a 
station that did not answer 

Go to Extension  Command to go to an extension.  To actually 
transfer the extension must be defined by one of 
the subscribers 

Go to Main Greeting  Command to go to the Main Greeting Menu 
Go to Subscriber  Command to go to a subscriber in the system 
In the Office  Command to check a subscriber in the office 
Line Answered  Indicates a line has answered 
Line Busy  Indicates a line is busy 
Line Has Dropped  Indicates the connected Trunk or Station has hung 

up 
Line is Ringing  Indicates a line is ringing 
Line No Answer  Indicates a line did not answer 
Log On  Used in the speech recognition mode to say the 

password 
Maid Status  Indicates which maid is in a guest room.  Used 

with InnFone 
Message Center Access  Provide direct access to message by using the 

primary extension number.  The  PIN number is 
asked for 

Monitor Caller (Trunk)  Used to allow a subscriber to listen to a caller 
leaving a message in their mailbox 

Out of the Office  Command to check a subscriber out of the office 
Record Conversation  Command to allow a subscriber to record an 

outside line call 
Record Emergency 
Message 

 Command to record the system emergency 
message and make it active 

Remove Emergency 
Message 

 Command to delete the emergency message and 
return to normal main greeting operation 

Request PIN Number on 
Voice Mail 

 Command to access Message Center after 
entering subscriber’s PIN Number 

Retrieve Caller (Trunk)  Command code for the subscriber to retrieve the 
outside line caller that they are monitoring while 
leaving a message in their mailbox.   

Set Active Company  Used to change companies in a multi-company 
installation 
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Take a Message  Defines the digits dialed to tell a screened caller 
to leave a message 

Trunk Forward  Indicates a Trunk has been forwarded to the 
system 

Trunk Hold Recall  Indicates a Trunk line has been returned to the 
system 

Trunk ID  Used with in-band signalling to specify trunk ID 

 
 
 
 
 
 

Main Greeting Signaling Definitions 
 

The Following Table defines the Main Greeting In Band Signaling 
parameters. 

 

NAME DEFAULT DESCRIPTION 
Answer NO to a 
Question 

  Answer no to a question prompted to a caller or 
subscriber 

Answer YES to a 
Question 

  Answer yes to a question prompted to a caller or 
subscriber 

Call Operator    Go to the Operator defined in the system 
Directory   Command used to enter into Directory Services 
Extension  Command to go to an extension.  To actually 

transfer the extension must be defined by one of 
the subscribers 

External Number  Defines an external or CO type number 
Forward Busy  Indicates a call has been forwarded from a station 

that was busy 
Go to Extension  Command to go to an extension.  To actually 

transfer the extension must be defined by one of 
the subscribers 

Go to Level  Command to go to another level inside a visual 
tree 

Go to Subscriber  Command to go to a subscribe in the system 
Invalid Call Control  Defines digits that will not be allowed 
Master Record  Indicates that this is a master record 
Undefined  Defines an unknown in band signaling input 
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Call Screening Signaling Definitions 
 

The Following Table defines the Call Screening In Band Signaling 
parameters. 

 
 

NAME DEFAULT DESCRIPTION 
Answer NO to a 
Question 

#  Answer no to a question prompted to a caller or 
subscriber 

Answer YES to a 
Question 

*  Answer yes to a question prompted to a caller or 
subscriber 

Call Operator    Go to the Operator defined in the system 
Extension  Command to go to an extension.  To actually 

transfer the extension must be defined by one of 
the subscribers 

Forward Busy  Indicates a call has been forwarded from a station 
that was busy 

Forward No Answer  Indicates a call has been forwarded from a station 
that did not answer 

Go to Extension  Command to go to an extension.  To actually 
transfer the extension must be defined by one of 
the subscribers 

Go to Subscriber  Command to go to a subscribe in the system 
Hot Talk Message ## Command to the system to record a real time 

message that is played back to a caller during call 
screening 

Invalid Call Control  Defines digits that will not be allowed 
Master Record  Indicates that this is a master record 
Record Conversation ** Command to record an outside line call 
Undefined  Defines an unknown in band signaling input 

 
 
 
 
 
 
 
 
Play Message Control Signaling Definitions 
 

The Following Table defines the Play Message Control In Band Signaling 
parameters. 
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NAME DEFAULT DESCRIPTION 
Fast Forward on Play 3 Command to Fast Forward 5 seconds during a 

message play 
Pause on Play 2 Command to Pause 5 seconds during a message 

play 
Rewind on Play 1 Command to Rewind 5 seconds during a message 

play 
Speed Down Play 7 Command to slow down the message playback 
Speed Reset Play 8 Command to reset the message playback speed to 

normal 
Speed Up Play 9 Command to speed up the message playback 
Volume Down Play 4 Command to decrease the volume of the message 

playback 
Volume Reset Play 5 Command to reset the volume of the message 

playback to normal 
Volume Up Play 6 Command to increase the volume of the message 

playback 

 
 
 
Define Phone Number Signaling Definitions 
 

The Following Table defines the Define Phone Number In Band Signaling 
parameters. 

 

NAME DEFAULT DESCRIPTION 
Answer NO to a 
Question 

#  Answer no to a question prompted to a caller or 
subscriber 

Answer YES to a 
Question 

*  Answer yes to a question prompted to a caller or 
subscriber 

Call Operator 0, 00   Go to the Operator defined in the system 
Extension XXX Command to go to an extension.  To actually 

transfer the extension must be defined by one of 
the subscribers 

Invalid Call Control  Defines digits that will not be allowed 
Undefined  Defines an unknown in band signaling input 

 

External Number XXXXXXX 
XXXXXXXXXX 
XXXXXXXXXXX 

Defines an external or CO type number 

 


